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R et Ll Tutorial Outline

Time (Tentative!) Module Topics Presenter

8:30-9:00 1. Eclipse and PTP + Installation of Eclipse and PTP Greg/Beth
Installation (can start early as people arrive)

9:00-9:30 2. Introduction & Overview Eclipse architecture & organization overview Greg

9:30-10:00 3. Developing with Eclipse Eclipse basics; Creating a new project from CVS; Beth
Local, remote, and synchronized projects

10:00-10:30 BREAK

10:30-12:00 3. Developing with Eclipse Continue from before the break... Beth, Jay, Jeff

(continued) + Beth: Editing C files; MPI Features; Building w/

Makefile

Continue at + Jay: Resource Managers and launching a parallel

1:00-1:45 gl

+ Jeff: Fortran, Refactoring, other Advanced
Features

12:00 - 1:00 Lunch

1:45-2:30 4. Debugging (45 min) Debugging an MPI program

2:30-3:00 BREAK

3:00-4:30 5. Performance Tuning & TAU, ETFw including hands-on exercise Wyatt Spear
Analysis Tools GEM, including hands-on exercise Alan Humphrey

4:30-5:00 6. Other Tools, Wrapup NCSA HPC Workbench, Other Tools, website, Jay/Beth
mailing lists, future features
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Final Slides, Installation
Instructions

+Please go to

for slides and
installation instructions
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Module 1: Installation

+ Objective
+ To learn how to install Eclipse and PTP

+ Contents
+ System Prerequisites

+ Eclipse Download and Installation of “Eclipse IDE for
Parallel Application Developers” — parallel package

+ Installation Confirmation

+ Updating the PTP within your Eclipse to the latest
release

Module 1
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About the Tutorial Installation

This tutorial assumes you have Eclipse and PTP pre-
installed on your laptop

If you already have Eclipse installed, go directly to
“Starting Eclipse”, slide 5

If you don't have Eclipse installed, you will need to
follow the handouts so that you can catch up with the
rest of the class

Note: up-to-date info on installing PTP and its pre-reqgs
is available from the release notes:

+ http://wiki.eclipse.org/PTP/release_notes/5.0

+ This information may supersede these slides

Module 1
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System Prerequisites

+ Local system (running Eclipse)

+ Linux (just about any version)
+ MacOSX (10.5 Leopard or 10.6 Snow Leopard)
+ Windows (XP on)

+ Java: Eclipse requires Sun or IBM Java
+ Only need Java runtime environment (JRE)
+ Java 1.5 or higher
+Java 1.5 is the same as JRE 5.0

+ The GNU Java Compiler (GCJ), which comes
standard on Linux, will not work!

+ Open]DK, distributed with some Linux distributions,
has not been tested by us but should work.

+ See http://wiki.eclipse.org/PTP/installjava

Module 1
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Eclipse Packages

+ The current version of Eclipse (3.7) is also
known as “Indigo”

+ Eclipse is available in a number of different
packages for different kinds of development
+ http://eclipse.org/downloads

+ With Indigo, there is a new package directly
relevant for HPC:
+ Eclipse IDE for Parallel Application Developers
+ This is recommended for all new installs

& Eclipse IDE for Parallel Application Developers (includes Incubating “Parallel

' components), 184 MB ”
Downloaded 13,799 Times  Detalls Package

+ Can also add PTP to an existing Eclipse
installation

Module 1
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Eclipse Installation

+ Download the “Eclipse IDE for Parallel
Application Developers” package
+ http://download.eclipse.org

+ Make sure you match the architecture with
that of your laptop

+ If your machine is Linux or Mac OS X, untar
the file

+ On Mac OS X you can just double-click in the Finder
+ If your machine is Windows, unzip the file

+ This creates an eclipse folder containing the
executable as well as other support files and
folders

Module 1
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Starting Eclipse

+ Linux

+ From a terminal window, enter
“<eclipse_installation_path>/eclipse/eclipse &”

+ Mac OS X
+ From finder, open the eclipse folder where you installed
+ Double-click on the Eclipse application
+ Or from a terminal window

+ Windows

+ Open the eclipse folder
+ Double-click on the eclipse executable

Module 1
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Specifying A Workspace

+ Eclipse prompts for a workspace location at
startup time

+ The workspace contains all user-defined data
+ Projects and resources such as folders and files
+ The default workspace location is fine for this tutorial

[F Workspace Launcher E@
Th e p rom pt can be Select a workspace

Eclipse Platform stores your projects in a folder called a

tU rned Off workspace.

Workspace: | S S Ll v Browse... |

[] Use this as the default and do not ask again

| ok || cancel |

Module 1
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Eclipse Welcome Page =)

+ Displayed when Eclipse is run for the first time
Select “"Go to the workbench”

)
Welcome to the Eclipse IDE for Parallel Application Developers

Module 1
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Check Installation Details

+ To confirm you have installed OK
+ Mac: Eclipse>About Eclipse
+ Others: Help>About

+ Choose Installation Details

+ Confirm you have the following installed
software

eNHO Eclipse Installation Details

[Installed Software | Installation History  Features Plug-ins  Configuration

Name Version Id
<+ Eclipse IDE for Parallel Application Developers 1.4.1.20110911-0506 epp.package.parallel

+ Close the dialog: Close, OK

Module 1

_——
-

D

Differs
depending
on base
download
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Checking for PTP Updates

+ From time-to-time there may be newer PTP
releases than the Indigo release

+ Indigo and “Parallel package” updates are released
only in Sept and February

+ PTP maintains its own update site with the
most recent release

+ Bug fix releases can be more frequent than Indigo’s
and what is within the parallel package

+ You must enable the PTP-specific update site
before the updates will be found

Module 1
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Updating PTP

au ‘,}\\\

+ Enable PTP-specific update site
+ Help>Install New Software...

+ Click Available Software
Sites link

+ Ensure this checkbox is selected for the PTP site:
http://download.eclipse.org/tools/ptp/updates/indigo

+ Choose OK

+ Choose Cancel (to return to Eclipse workbench)
+ Now select Help>Check for updates

+ If you see “No updates were found”...

+ It's only because there are no updates in the
“Eclipse IDE for Parallel Application Developers”

+ We will update the PTP within it

Module 1
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_——
-

Updating PTP (2) =

+ We will get the PTP release that is more recent than what
is currently (Nov. 2011) within the parallel package

+ Now select Help>Install New Software...

+ In the Work With: dropdown box, select the PTP update
site you confirmed already:

H 00 Install

Available Software |
Check the items that you wish to install.| »

9.

Work with: vPTP—http.f/download.eclipse.org,‘tools/ptp[updates/indigo 3 ( Add...

Find more software by working with the "Available Software Sites" preferences.

pe niter text

Version
Ul Fortran Development Tools (Photran)

J00 Parallel Tools Platform
U0 Remote Development Tools

—r v} -
U S
3
m

Module 1
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Updating PTP (3)

+ Quick and dirty:

+ Check everything - which updates existing features and adds a few more

JUU Fortran Development Tools (Photran)
JU0 Parallel Tools Platform
U Remote Development Tools

+ Detailed:

+ Open each feature and check the ones you want to update

+ Icons indicate: Grey plug: already installed
and up to date — f
Double arrow: can be updated =j..|£f‘PTP Parallel
Color plug: Not installed yet @ PTP Parallel

: . = PTP Parallel
Note: For this tutorial, install GEM and TAU

L+ PTP External Tools Framework TAU Extension
L PTP External Tools Framework TAU Extension for Fortran
= PTP Graphical Explorer of MPI Programs (GEM)

Note: if conference network is slow, consider unchecking:

[2] Contact all update sites during install to find required software
Module 1
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Updating PTP (4)

aw ‘2\\

+ Select Next to continue updating PTP

+ Select Next to confirm features to install

+ Note: if you are NOT on Linux: You may have to go back and un-
select, under Fortran Development Tools (Photran), the “Linux Intel
Fortran Compiler Support” - if it complains

+ Accept the License agreement and select Finish
%O Installing Software
| Installing Software Wait for installation to
‘ finish
e If conference network is
L Always run in background | too slow, we have this
CGneel ) (e >> ) (Ruminbackgrounany cached on USB/CD/DVD

+ Select Restart Now when prompted
8.N.C Software Updates

1 You will need to restart Eclipse for the installation changes to take effect. You may
try to apply the changes without restarting, but this may cause errors.

- Not Now ) ( Apply Changes Now ) Restart Now )

Module 1
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Restart after Install

If any top-level
features are installed...
Welcome page informs
you of new features
installed

We only updated PTP,
so we land back at C/C++
Perspective

... Ready to go!

Help>About or Eclipse > About Eclipse ...
will indicate the release of PTP installed

Further Help>Check for Updates will find future updates
on the PTP Update site

Module 1
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Module 2: Introduction

+ Objective
+ To introduce the Eclipse platform and PTP

+ Contents

+ New and Improved Features
+ What is Eclipse?
+ What is PTP?

Module 2
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New and Improved Features

+ More flexible projects

+ Synchronized projects overcome many problems of
remote projects

+ Allows development when “off-line”
+ Works with non-C/C++ projects

+ More customizable resource managers
+ Resource managers can now be added by users

+ Able to have site-specific configurations

+ Interactive launch using job schedulers now
supported

Module 2
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New and Improved Features (2)

+ Scalable system/job monitoring

+ New perspective allows monitoring of systems of
virtually any size

+ View shows location of jobs on cluster
+ Active and inactive jobs views

+ Remote support for performance tools

+ External Tools Framework has been extended to
support remote systems

+ Performance tools such as TAU can now launch and
collect data from remote systems

Module 2
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What is Eclipse?

+ A vendor-neutral open-source workbench for
multi-language development

+ A extensible platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools

Platform

User

Module 2
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Eclipse Features

+ Full development lifecycle support

+ Revision control integration (CVS, SVN, Git)
+ Project dependency management

+ Incremental building

+ Content assistance

+ Context sensitive help

+ Language sensitive searching

+ Multi-language support

+ Debugging

Module 2
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Parallel Tools Platform (PTP)

The Parallel Tools Platform aims to provide a highly

integrated environment specifically designed for parallel
application development

Features include:

+ An integrated development environment (IDE) that

supports a wide range of parallel architectures and runtime
systems

+ A scalable parallel debugger

+ Parallel programming tools
(MPI, OpenMP, UPC, etc.)

+ Support for the integration
of parallel tools

+ An environment that simplifies the E
end-user interaction with parallel systems

+ http://www.eclipse.org/ptp

Module 2
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Eclipse PTP Family of Tools

Coding & Analysis o Launching &
(C, C++, Fortran) - ‘ Monitoring

i/ - Edlipse SOX.

clpse SOK

=5 [ Fortran] P ——————

T Fortran Projects 32 SE Outline 52 =8
= : B R e
. || mosne raataser .
> e B lupricis nene RlegyTe—
< 5 >org.ectpse. photran samp , © O Taaaser
> G iares

° datapt ok 53 probns pr
> @ src-ixedfom real + datapt(4, 1000)
i nts

s
> Gsrc fortran-ana-c 0 : vaisum 015 -Root [§]

" B > (A src-gaussian-elimination vatsum ‘

-
22222223

Exb0
> srcincludes mbt
b2
b3

| tegica + has_np(2)
> fsrc-danguage-Teatures end type Toataset

< ) >src-ine-iting end module Miataset

j.cvsignare 1.1 (asc)| || Presran BstFitProg © ShowDataoints

> Ghsremosuies 0 _ use maataset °_sauarenistances (%]

g I 0 < I i 0]

@ Make Targets 32 =5 [2 provtems 51 Console Properties # 7 =8
5 b |26 erors, 0 warmings, 0 nfos

R = =
B Descrption Resource
> Worg.ecipse.phatran-sampies =

> Ewnateverz © Derived type definton has o components, bug138221 f‘

©FILE tag must beof type CHARACTER bugaiseras
 egat preprocessorarecive g6 1
o]

&% 0- . © A . 5 [Btparae Debug| Hipaate unt... ERemote C/C.
BB parael peg 5B a - - = 0|9 meakpol (&7 Expresst [0 variaies 50 o Signals| 11 Arays | 9 variaes
Open MPI@sbe ncsa e edu: defuitjobd

B
B0 @ Y

Value
1

-
Sosrsnse 30

0uhun 54 fo-
E llow [Parallel Application] -
Process. e

P Thread 1) Guspended) e =

{8 maine 23
WPI_Datatype * setup_resO;

2 outne %
BRE o %
main (argc, argv) £ mathh
int arecs O & i
e e : & wdon
U decsh
workard : void
Letupres WP Datatype
i, char )
Setup_res0 WPLtate
Update.slobal P Dt

<
> float

t  di-tpi/(Float)n;

B Console 2 .0 Memory| (£ Problems
Open MPIGabe.ncsa.uiuc edudefaultiond

Open Mpl Job

Performance Tuning Parallel Debugging
Module 2 (TAU, PPW, ...) 2-6




File Edit Navigate Search Project Run Window Help
$r O Qv | [Er

FF Fortran Projects 52 =0

_module Mdataset
D EEMMFP = implicit none

¥ % >org.eclipse.photran-samp

| Declare a Tda et e to hold data points

P < Binaries type :: Tdataset
D (4 src-fixed-form real datapt(4,1000)
- integer npts

D} src-fortran-and-c X real valsum(4)
real valsum(4)

L real xysum(3)
logical has_np(2)

end type Tdataset

D} src-gaussian-elimination
D (4 src-includes
D src-language-features

¥ 3 >src-line-fitting end module Mdataset

program BstFitProj
3 .cvsignore 1.1 (ASCI

D (fi src-modules @  use Mdataset

1 I [) [«
@ Make Targets &2 = 0O |l Problems 2 Console | Properties
% D | 26 errors, 0 warnings, 0 infos

N Description
D =S org.eclipse.photran-samples - -

whatever2 @ Derived type definition has no components

@ FILE tag must be of type CHARACTER

@ llegal preprocessor directive

Module 2
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How Eclipse is Used
Editing/Compiling

B ‘@Fortran‘
Outline 53 =g

% ]

< () Mdataset

v ) Tdataset

¢ datapt

¢ npts
¢ valsum

¢ valsum

¢ xysum

¢ has_np

v P BstFitProj

¥ LoadDataSet

“  ShowDataPoints

¥ SquareDistances

Resource

bug138221.f

bug118974.f

bug118961.f[
[»)
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How Eclipse is Used
Launching/Monitoring




o o B0 Q- Q- |O-
#5 parallel Debug 2 B &
Open_MPI@abe.ncsa.uiuc.edu: default;job0 - Root [4]

£3jobo @y

5 Debug 83
8} shallow [Parallel Application]
&@ Process 0
hread (1] (Suspended)

1€ main.c 8

2MPI_Datatype * setup_res();

main (argc, argv)
int argc;
char * argv(l;

float  pi=4.*(float)atan((doubl
float p[nl[ml; /% P
float  u[n][m];

float  v[n][m];

float  psi[n][m

float  pold[n][m];
float uold[n][m];
float  vold[n][m];
float  h[n][m];

float  z[n][m];

float  dummyl[m];
float  dummy2[n]
float i=pi+pi;
float  di-tpi/(fFloatdm;
float  dj=tpi/(float)n;

& console
Open_MPI@abe.ncsa.uiuc.edu:default:jobd

@ Memory| £ Problems

Module 2
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How Eclipse is Used
Debugging

[ B Parallel Debug 338 Parallel Runt... FZiRemote C/C...

Expressi

©9= Variables 3

Signals Arrays | (9= Variables

Value

1
7Hffifdes8
5.957805E-39
[0-18]
[0-18]
[0-18]

(0 - 18]

Outline 23

BV o %
math.h
mpi.h
stdio.h
decs.h
worker{) : void
setup_res() : MPI_Datatype*
main(int, char*(])
setup_res() : MPI_Datatype*
update_global_ds(MPI_Datatype

Open Mpi Job
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How Eclipse is Used
Performance Tuning

Module 2
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Module 3: Developing with Eclipse

+ Objective

+ Learn basic Eclipse concepts: Perspectives, Views, ...
+ Learn about local, remote, and synchronized projects
+ Learn how to create and manage a C project

+ Learn about Eclipse editing features

+ Learn about Eclipse Team features

+ Learn about MPI features

+ Learn how to build and launch an MPI program on a
remote system

+ Learn about Fortran projects
+ Learn about searching, refactoring, etc.
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Contents

Basic Eclipse Features (3-2)
(3-13)
(3-24)
(3-34)
(3-40)
(3-56)
(3-62)

(3-82)
(3-90)

(3-108)
(3-113)

+
+
+
+
+
+
+
+
+
+
+
+
+

<
S)
Q
=
@
W
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Basic Eclipse Features
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Eclipse Basics

+ A workbench contains the menus, toolbars, editors and
views that make up the main Eclipse window

+ The workbench represents
the desktop development
environment

+ Contains a set of tools
for resource mgmt

+ Provides a common way
of naVigating through putsC"1 | ello Worddi11°3; /% prints 111
the resources _
Multiple workbenches editor
can be opened at the
same time

Only one workbench can view
be open on a workspace

at a time
Module 3 perspective

Writable S I
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Perspectives

+ Perspectives define the layout of views and
editors in the workbench

+ They are task oriented, i.e. they contain
specific views for doing certain tasks:

+ There is a Resource Perspective for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives

+ If you are on the Welcome screen now, select
“Go to Workbench” now &

Module 3
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Switching Perspectives

hrch  Project Run RULGIUE Help

C/C++  New Window
# New Editor

f—=%  Open Perspective » & Debug

+ Three ways of changing 35 et R N

. Name | Customize Perspective... Other...
pe rS pectlves Save Perspective As...
Reset Perspective...
Close Perspective
. Close All Perspectives

1. Choose the Window>Open Fincoas e i
Perspective menu option — - |
Then choose Other... 1B Cvs Repository Exploring

%> Debug
£ PTP Debug

Click on the Open Perspective button in the ol
upper r|ght corner Of (5 Resource

screen (hover over it to L} s

see names)

4 000
aan Parallel Runt... 0K [ cancel |

3. Click on a perspective
shortcut button

+ Switch to the C/C++ Perspective
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e ‘,}\\\

Which Perspective?

+Which Perspective am in in?
See Title Bar

C/C++ - MyHelloProject/src/MyHelloProject.c - Eclipse SDK -
File Edit Sour - Refactor Navigate Search Project Run PAPI Window

Civ B & w | @v &v [dv Gv | Qv BY | v Qv @:v Qv | Ov
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Resource - MyCproject/src/MyCproject.c - Eclipse SDK
File Edit Refactor Navigate Search P i |

Views

+ The workbench window is
divided up into Views

+ The main purpose of a view is:
+ To provide alternative ways of presenting information
+ For navigation
+ For editing and modifying information

4+ Views can have their own menus and toolbars

+ Items available in menus and toolbars are
available only in that view

+ Menu actions only —
apply to the view 5= Qutline 52

+ Views can be resized ¢ main():int

Module 3
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Stacked Views

+ Stacked views appear as tabs

+ Selecting a tab brings that view to the
fO reg rO U n d 800 Remote C/C++ - hello/hello.c - Eclipse - /Users/beth/ews/test0917c
S Eiv&iv [ @r ||~ X ea

838 Parallel Runt... FiclRemote C/C...
B | [E M| FE e

: N
[ Projec 83 8 Remo | = O/[[<] hello.c £3 = O|[ 8 outline 2
= -4 A ‘ﬂz \
. . hel =l stdio.h
= stdlib.h
@ main(void) : int

=5 hello
\.c| hello.c
nit Includes

#include <stdi >
#include <stdlib.h>

int main(void) {
puts("!!!Hello World!!!"); nts
return EXIT_SUCCESS;

111Hello World

ETTTTTTTTIZISSN. >

2

E console £ _[Z( Problems | 12® Remote Call Hiera | f¢ Remote Type Hier | [ Remote Environm =0
C-Build [hello] BH Gk |2 Bv [

gcc -g -0 hello hello.c

Writable Smart Insert - | Remote Tools DStore S...c.edu): (100%)
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Expand a View

+ Double-click on a view/editor’s tab to fill the
workbench with its content;

+ Repeat to return to original size

B |[FRc/c++ & |Egc/c++

o= Outline 52 =0

8~ [&v G~ v 5y T4 o | & &8 [Ey @ v v
% S & v | FrQ-Q- Q- | @ v |
C| ®
Copyright  : A 2R e - ite
c Jescription R W b f L | Description A |Resource Path
= hello ™ stdio.h
[ Includes */ = stdlib.h
@ src @ main(void) : int
include <stdio.h>
inclu ib.h> 1

Double
click

return EXIT_SUCCESS;
«
Problems £3 . = Tasks | & Console
0 items
Description

v e

A Resource Path

L e ]




To access help
+ Help>Help Contents
+ Help>Search
+ Help>Dynamic Help

Help Contents provides
detailed help on different
Eclipse features in a
browser

Search allows you to
search for help locally, or
using Google or the Eclipse
web site

Dynamic Help shows help
related to the current
context (perspective, view,
etc.)

Module 3

para

Help

- Help - Eclipse

Sea

rch:

i| Contents (EiRd

& Workbench User Guide
\_";)
€

= C/C++ Development User Guide

Autotools Plug-in User Guide

C/C++ Library Documentation
Changelog Editor User Guide
Eclipse Marketplace User Guide
GCov User Guide

GNU Tools

& GProf User Guide
& Libhover Developer's Guide

¥ Mylyn Documentation

Parallel Tools Platform (PTP) User Guide
Photran User's Guide

Remote Development Tools User Guide

¥~ RSE User Guide
@ Usage Data Collector

el—tools platform

Scope: All topics

Using the help system

Browse topics in the Contents frame (@) on the left. Click on a
topic to have it displayed. Use the Back and Forward buttons to
navigate within the history of viewed topics.

Searching

To quickly locate topics on a particular subject in the documentation

enter a query in the Search field. Use the Search frame () to
display the Search view. You can narrow the scope of your search
by selecting only the sections you are interested in.

Synchronizing
Clicking the Show in Table of Contents button (&%) will select that

topic in the navigation tree. The Link with Contents button ()
keeps the navigation tree synchronized to the current topic

Capabilities




Build
Code Analysis
Code Style
Debug
Editor
Content Assist
Folding
Hovers
Mark Occurrences
Save Actions
Scalability
Syntax Coloring
ﬁ
Indexer
Language Mappings
New CDT Project Wizard
Property Pages Settings
Task Tags
Template Default Values
XL C/C++ Compiler
XL C/C++ Language Option

Changelog

paratieltools platform

Eclipse Preferences

Preferences

Typing

Automatically close

121 “Strings”®

12] (Parentheses) and [square] brackets
[Y] <Angle> brackets

[YI {Braces}

Tabulators
[2] Tab key adjusts indentation of the current line

The tab display value (currently 4) and whether spaces are
used to indent lines are configured on the code style
preference page. The current indentation mode uses tabs.

When pasting

121 Adjust indentation

In string literals
[Y] Wrap automatically

(] Escape text when pasting into a string literal

Automatically indent

™ New lines and braces

+ Eclipse Preferences allow

customization of almost
everything

To open use
+ Mac: Eclipse>Preferences...

+ Others:
Window>Preferences...

The C/C++ preferences
allow many options to be
altered

In this example you can

o , . adjust what happens in
¢ ) Ly J the editor as you type.

e \ \

( cancel ) 0K )

S
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Preferences Example

e NO Preferences

type filter text Code Style G More C/C+ + preferences:

General

+In this example the

C/C++ Select a profile:

e ouiin B o D (oo Code Style preferences

b(.k')de.Se C New.. ) ( Import.. ) are Shown

Editor Preview:

Environment /* * These a”OW COde tO be

File Types * A sample source file for the code formMter pre .
Indexer =
Language MaIHDID) Profile 'K&R [built-in]' a uto Y at| Ca I Iy
New CDT Pro| c .
property pag{_Profe e R = formatted in different
Scripting : [
Task Tags Indentation Braces White Space Control Statements Line Wrapping W y
Template Def a S
XL C/C++ Cq
XLC/C++ La WOESIEE
Fortran ] Use tabs only for leading indentations
IHelp o Ty . #include <math.h>
nsta ate
Java /up Tab size: [ | class Point {
. public:
JavaScript Point(double xc, double yc) :
Parallel Tools Indent x(xc), y(yed {
Plug-in Develop) [ 'public', 'protected', 'private’ within class body }

General settings Preview: () Show invisible char.

Tabs only /* A
* Indentation
*/

Remote Systems ™ Declarations relative to ‘public’, 'protected’, 'private’ double distance(const Point& other) cons|
Remote Tools o - _ int compareX(const Point& other) const;
Run/Debug ¥ Statements within function body double x;

double y;
Server # statements within blocks . oubte i
;

Service Conﬁgul ) Statements within 'switch' body
TAU Configurati - double Point::distance(const Point& other) ¢
®5tatements within 'case’ body double dx = x - other.x;

Team double dy = y - other.y;

Validation ™ 'break’ statements

Web ] Declarations within ‘namespace’ definition return sgrt(dx * dx + dy * dy);

| }
Web Page Editor, ] Empty lines

XML in; Point::compareX(const Point& ot);er) cons
« >

Cancel
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Projects In Eclipse
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Project Types

+ Local

+ Source is located on local machine, builds happen
locally
+ Synchronized

+ Source is local, then synchronized with remote
machine(s)

+ Building and launching happens remotely
(can also happen locally)
+ Remote

+ Source is located on remote machine(s), build and
launch takes place on remote machine(s)
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Synchronized Projects

S C/C+~ - testOpenMP.c - C:\ews\runtime-workspace-sc05local - Eclipse SDK
File Edit Refactor Navigate Search Project Run LAPI Artifact MPI Artifacts  OpenMP Artifact Window Help.
5. B R0 N O P )
[¢) Edmiston_Solution. ! = O[5 outine &
alm

(double *)
(double *)

S pi.cop ¥ #pragma omp parallel for
=2 MyCProject for (1= 0; i< arraySize; i++ )
55 MyMPIplusOpenMP {
=l &5 >MyOpenMPproject [lexcvs L.lexingto vIil sin( exp( cos( - exp( sin(x[i])
(& Includes 3

€ 11 (A
FieOrig.c 1.1

o
se.c 1.1 (ASCI 4
) >testOpenP.c 1.1 (ASCII +kv)

% &5 PTPSmulation
¥ & Remotes, T
& € omp_in_paraliel
. OpenMP Pragma

h

- Executable

writable SmartInsert | 26:6

Search/Index
Navigation

Synchronize
Local source > Source code

code

Local Remote
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Remote Projects

File Edit te Search Project Run LAPI Artifa MPI Artifacts  OpenMP Artifacts  Wind
0-%- ik | m® | &

@ clc++Projects 52\ Navigator| = <) Edmiston_Solution... {¢] testopenMp.c &3

S C/C++ - testOpenMP.c - C:\ews\runtime-workspace-sc05local - Eclipse SDK

X [ndudes D &

(& Indludes (double *) ma

= Debug (double *) malloc(
emote

iy vivek's version
{5} >Edmiston_Solution
LAPIsample
mpi_cpp
(2 Indudes i =
IS pi.cop @ #pragma omp par for
MyCProject for (i =0; i < arraySize; i++ )
MyMPIplusOpenMP {

OpenMPproject [lexcvs Llexingtol vIi] = sin( exp( cos( - exp( sin(x[i])

des

|

€ 1.1 (ASCII
CFileOrig.c 1.1 (ASCII kv) return 0;

1.1 (as
if) >testOpenMP.c 1.1 (ASCII kv)
PTPSimulation
RemoteSystemsConnections

PR ereraaas

Opentp Arti Construct
(@ omp_in_parallel c Fun
OpenivP Pragma

Executable

Source code

Remote
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C, C++, and Fortran Projects
Build types

+ Makefile-based

+ Project contains its own makefile (or makefiles) for
building the application
+ Managed

+ Eclipse manages the build process, no makefile
required

Parallel programs can be run on local machine or
on a remote system
+ MPI (or other runtime) needs to be installed

+ An application built locally probably can’t be run on a
remote machine unless their architectures are the same

Module 3 3-17
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Checking out the project

Using a Source Code Repository

Introduction to Team Features
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Importing a Project from CVS

+ Switch to CVS Repository
Exploring perspective
+ Window > Open Perspective > Other... m—
+ Select CVS Respository Exploring

?‘;} Debug

+ Select OK F-

‘;\Jjava Browsing
fodjava Type Hierarchy
ngParallel Debug

885 Parallel Runtime

;E Remote System Explorer
[y Resource

Liis System Monitoring
E£YTeam Synchronizing

+ Right click in CVS Repositories
view and select New>Repository
Location...

CVS Repository Exploring - Eclips,

» & Repository Location...
Paste Connection 3V

5* Refresh View
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o L

Add CVS Repository ‘*

eSO Add CVS Repository

+ Enter Host: dev.eclipse.org Add 2 new CVS Repository

+ Re pOSito ry path : S Rew epository to the epositories view
/cvsroot/tools

Host: dev.eclipse.org
Repository path:  /cvsroot/tools

Authentication

+ For anonymous access: User: [anomymoud

+ User: anonymous el |
+ No password is required R
+ Connection type: pserver (default) Connection type: |-pserver

(® Use default port

+ For authorized access: O Use port:

@ Validate connection on finish

+ User: your userid
i Password : your password To manage your password, please see 'Secure Storage'
+ Connection type: Change to extssh Configure connection preferences...

[) Save password (could trigger secure storage login)

4+ Select Finish

( cancel ) € Finish—)
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Checking out the Project

Mo CVS Repository Exploring

Q- | B A | eF
[/ CVS Repositories &3

Expan d the re pository location R e e mlaenion:

= CVSROOT

CIPaTT =3
Expand org.eclipse.ptp, doc,
and samples

Right click on shallow-mixed Sonay

(=articles
a n d Se I eCt C h eck o ut AS (= org.eclipse.ptp.doc.isv
EER (= org.eclipse.ptp.doc.user
(= presentations

+ On Check Out As dialog, select i

» f= shallow-mixed

L - (= tutorials New
I n I S e NoOo Check Out As (= whitepapers

: Check Out
Check Out As X| .project 1.1

- .
Select the method of check out L | “n" project_log.csv 1.3 k
(=old

(=>org.eclipse.gef

(= org.eclipse.orbit
(=>org.eclipse.pdt

(= org.eclipse.pdtincubator
(= org.eclipse.ptp

iz Tag as Version...
= phot
Th e d efa u It Of Choose how to check out folder 'shallow' :fmo o Tag With EXiSting-'-

(® Check out as a project configured using the New Project Wizard (=>releng

P .
W C h e C k O ut a S a () Check out as a project in the workspace k= rms aste Connection

@ tools Compare With...
Project Name:

project configured S ol 1.4 Compare

(O Check out into an existing project (= org.eclipse.tm.core Expand All

0 (> org.eclipse.tm.rse Add to Branch List...
USI ng the NeW (= org.eclipse.uml|2.releng

# Checkout subfolders &’ Configure Branches and Versions...
(= org.eclipse.ve

o ¥ n jorking sets
PI"OJ eCt W 1Za I"CI IS oo (= org.eclipse.ve-feature £ Refresh View

() Add project to working sets (= org.eclipse.ve.cde

W h at W e Wa nt Working sets: . elec (= org.eclipse.ve.doc

(= org.eclipse.ve.examples
(~>org.eclipse.ve.examples-feature

Module 3
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. 53

New Project Wizard

As project is checked out from CVS, the New Project
Wizard helps you configure the Eclipse information to
be added to the project

+ Expand C/C++
Select C Project and click on Next>

Enter ‘shallow’” as Project Name
Under Project type,
expand Makefile project 800 C Project

- scroll to the bottom C Project

Create C project of selected type

Select Empty Project

Select a toolchain that Project name: | shallow
matCheS your System from M Use default location

Location: Users/beth/ews/test1027-scll-tutorial/shallow

Toolchains

+ Since we will build/run this on
Project type: Toolchains: .
the remOte SyStem, Choose W EACCU T (T T OO OTT T WACUSA BErReiey Urc For SC tuto rla |

. . & Executable (XLF Fortran on Ma~ |  MacOSX GCC ~
an approprlate tOO|Cha|n (= Makefile project MinGW GCC Choose

® Empty Projec .
You may need to uncheck pty Project 0 § 0 Remote Linux

- h @ Empty Project - Fortran Remote XL C/C++ Tool Chain
ShOW pro.]e(:t types a nd ® Demo - Hello World - Fortr ¥ Remote XL UPC Tool Chain GCC TOOl

o e ) > Solaris GCC b
[_) Show project types and toolchains only if they are supported on the platform Ch a | n

Choose file system:

toolchains only if they are
supported on the platform”

4+ Click on Finish
Module 3
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C/C++ Perspective

(.9 Open Associated Perspective?

1 This kind of project is associated with the C/C++ perspective. Do you want to

SWitCh tO the C/C++ Perspective - open this perspective now?
When Prompted ") Remember my decision

You should now see the “shallow” project in your
workspace

C/C++ - IBM PE Developer Edition - /Users/beth/ews /test0930ppedev
TERCEESEACARC AR SA-:CRAE 24 2> R A Nr=1prd Y [BaCVS Reposit...  »
O- |12 v

L[ Project Explorer &3 =0|[@m BT™ =7

-

m shallow [dev.eclipse.org] An outline is not available.

Expand the
project root
to see the
project’s
contents

t

jt
1) Wi r.c 1.2
(yMakefilemk 1.2

[£( problems 53 % Tasks | Bl Console | =1 Properties | 5 Remote Enviro| = O
0items -

Description A |Resource Path

=5 shallow
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Editor Features
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Editors

+ An editor for a resource (e.g. a file) opens when you
double-click on a resource

+ The type of editor depends on the type of the resource

+ -C files are Opened With the L[ Project Explorer £3 AﬁRemoteSystems =
C/C++ editor by default T —— :

+ YOU Can use open With to YL:]‘copy.c Aj
use another editor Yo

+ In this case the default e Copy R e SIC Sttt
. . - : Lr'\‘l c>'~' Paste [5) Text Editor
editor is fine (double-click) Branc 1 % Delete S

L. tstep.c 1.1 Remove from Context Default Editor

. worker.c 1 Source

>
A7 aclocal.m4
i Move... . Other...

+ Some editors do not just edit raw text

+ When an editor opens on a resource, it stays open across
different perspectives

+ An active editor contains menus and toolbars specific to that
editor

Module 3
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Saving File in Editor

+ When you change a file in the editor,
an asterisk on the editor’s title bar
indicates unsaved changes

lc] *hello.c 23

+ Save the changes by using
Command/Ctrl-S or File>Save
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Editor and Outline View

Double-click on

| | C/C++ - shallow/main.c - Eclipse - /Users/greg/Documents /workspace

source file -

L[ Project Explorer &3

Editor will open in |§g&
main view

-

-shallow
L.y calc.c 1.1
|.¢) copy.c 1.1

Eiv &9y [+ ©r

= 0/ [ mainc 8

RS-0 Q|BS - O-

raut molcting WW11) FCUPWEKOEL.CO. FMLT.0Z
in Dix (DAR) mr l.co.rmit.oz *
BSD c¢ using Argonne nacr *
Unix System V

Multimax 320

* Mar.
* Language

* 0/S

* H/W Encore
*

*

KKK KKK KKK KKK KKK KKK KKK R

| diag.c 1.1
| dump.c 1.1

[n)t Includes

| init.c 1

L. time.c 1.1
L. tstep.c 1.1
.y worker.c 1.1
Afjaclocal.m4 1
3 AUTHORS 1.1
3 Changelog

Outline view is
shown for file in
editor

Console shows
results of build,

5 config.guess 1.1

3 config.h.in 1.1

3 config.sub 1.1

3 configure 1.1
Af configure.ac 1.1

§ COPYING 1.1

) depcomp 1.1

§ INSTALL 1.1

jinstall-sh 1.1
A Makefile.am 1.1
Ay Makefile.in 1.1
(3 Makefile.mk 1.1

j missing 1.1

[2/ Problems | ¥ Tasks | Bl Console 53
No consoles to display at this time.

<math.h>
<mpi.h>
<stdio.h>
"decs.h"

#include
#include
#include
#include

extern void worker();
MPI_Datatype * setup_res();

int argc;
char * argv[];

float
float
float
float
float
float
float
float
float
float

pi=4.*(float)atan((double)l.);

pLn]Cn]; /* Pressure (or free surface height) */
uln][m]; /* Zonal wind */

v[n][m]; /* Meridional wind */

psi[n]J[m]; /* Velocity streamfunction */
pold[n][m];

uold[n][m];

vold[n][m];

h[n][m];

z[n][m];

€ : )

=1 Properties tb Remote Environments

local runs, etc.

€| /shallow/main.c

—>

=0

[

EY [@3CVs Reposit... FgC/C++

o,
o

Zouw X\ _@mak| 0O
RN o %Y

math.h

mpi.h

stdio.h
decs.h
worker() : void
setup_res() : MP;
main(int, char*[])
setup_res() : MPI_Datatype
update_global_ds(MPI_Dat:
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Source Code Editors & Markers

A source code editor is a [ElrERrTS s
special type of editor for o i e

manipulating source

double evaluate(double X)

code S R | |
. add semicolon to end of next line

Language features are g ——double.y 23.0%.£.2.9

highlighted

Marker bars for showing

+ Breakpoints

+ Errors/warnings

+ Task Tags, Bookmarks

Location bar for
navigating to interesting

features in the entire file ¢/ Task tag
Warning
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Code Analysis (Codan)

+ If you see bug icons in the editor marker bar,
they are likely suggestions from Codan

+ Code checkers can flag possible errors, even if
code is technically correct

+ To turn them off, use Preferences

}
Window > Preferences or Mac: Eclipse > Preferences THGHDR

C/C++ > COde AnaIySIS H.. Problems 83 . | Tasks| & Console | = Proj

a n d U n Ch ECk é 1 error, 2 warnings, 0 others

type filter text ode Analysis =R Description
all problems y [ : © Errors (L tem)

5 Warnings (2 items)

A ame everit : . . . o, ,
Select OK to A s N\ Potential Programming Problems A Possible assignment in condition 'x=1
L — : - ] .
A :
SIATRRATS ssig ondition Warning
tate o effect 5 Warnin

.1 Possible assignment in condition 'x=1'
close

Preferences




paratle

Line Numbers

.| hello.c &3

+ Text editors can show line numbers in the

left column

+ To turn on line
numbering:

+ Right-mouse click in
the editor marker bar

4+ Click on Show Line
Numbers

3 Name
1 Author
Version

6 Copyrig
.c| hello.c 3

v)

Author 1 #include

Toggle Breakpoint 1t notic

Enable Breakpoint in C, Ansi-style

1
1
12 #include
s
-st

Breakpoint Types p [TUTTTEETEEEEmEmmmmmmmmmmm——

Add Bookmark...
Add Task...

v Show Quick Diff ~0Q

S'iow Line NumBerS ); /% prints !!!lHello Wo

Folding >

Preferences...

rld
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Navigating to Other Files

+ On demand hyper“nk [c) main.c £3 . [h] decs.h €] init.c
¥
4+ In main.c line 135: ‘

+ Hold down Command/Ctrl key
e.g. on call to initialise

+ Click on initialise to navigate
to its definition in the header file
(Exact key combination
depends on your OS) [0 maine [\ decsh [[cinine i3

26 #include <math.h>
+ E.g. Command/Ctrl and click on 27 #include *Qps.h'

Q ArLm o 29void initialise(p, u, v, psi, pold, uold, vold, di, dj, z)
Inltlallse 30 float p[n][m];

31 float u[n][m];

32 float v[n][m];

+ Open declaration  Floas pei it

+ Right-click and select Open
Declaration will also open the OPERE F3

#include <<t Open Type Hierarchy F4

file in which the element is #include <=f; Open Call Hierarchy T
' ) ~ Quick Outline #0
declared int main(vol  qick Type Hierarchy 8T

ts("!!
puts( Explore Macro Expansion ¥=

+ E.g. in main.c line 29 right-click " roggle Source/Header  ATab
on decs.h and select Open
Declaration Note: may need to left-click
Module 3 before right-click works

31 /*

1

1

1

1

1 initiaglise data structures and construct packets to be
133 %/

134
1

1

1

1

1

initialise(p, u, v, psi, pold, uold, vold, di, dj, z);
p, u, v, h, z);

for (1 = 1;\1 < proc_cnt; i++) {
9; J < n; Jed {

irld!!
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Content Assist & Templates

+ Type an incomplete function name e.g. “get” into the editor,
and hit ctrl-space

+ Select desired completion value with cursor or mouse

lint main(void) {
puts("!!!Hello World!!!" /* prints !!!lHello World!!! */
get

y yeluian_uliiucn vUIU) L
‘1

[

1:
]
1!
1¢
1
1
]

[ A
: ret [ bt * * __lineptr,* _ n,int __delimit
} * _name) : char * O
9 getline(char * * __lineptr,* __n,FILE * __strear

neatlnadavaldnuhle * lnadawva int nelam)
18

Press "~Space’ to show Template Propos

Hit ctrl-space again

+ Code Templates: type for code templates

‘for” and Ctrl-space

-| for - for loop for (int var = 9; var < mcix; ++var) {
-| for - for loop with temporary variable ;

More info on code templates later
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e

Inactive code

+ Inactive code will appear grayed out in the
CDT editor

60 #define VAL

61 #ifdef VAL

62 acopy_one_to_two(VAL, ds, .indx);

63 #else

: acopy_one_to_two(res.row, res.indx);
65 #endif

60 //#define VAL

61 #ifdef VAL

62 acopy_one_to_two(VAL, ds, .1ndx);

63 #else

: acopy_one_to_two(res.row, res.indx);
65 #endif
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Team Features
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“Team” Features

+ Eclipse supports integration with multiple
version control systems (VCS)
+ CVS, SVN, Git, and others
+ Collectively known as “"Team” services
+ Many features are common across VCS
+ Compare/merge
+ History
+ Check-in/check-out
+ Some differences

+ Version numbers
+ Branching
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CVS Features

+ Shows version numbers next to
each resource

+ Marks resources that have
changed

+ Can also change color (preference HEaNN
option)

wei  Build Selected File(s)

+ Context menu for Team
operations

+ Compare to latest, another
branch, or history

+ Synchronize whole project (or any
selected resources)
Module 3

# Run C/C++ Code Analysis

Properties

tart;je=jend; j++) {
j+1) %

n;
Synchronize with Repository

Update X
Create Patch...
Apply Patch...

3
Another Branch or Version... [
Each Other '])

History... ;
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File Modification

+ Open “calc.c”
+ Add comment at line 40
+ Save file

+ File will be marked to
indicate that is has been
modified

L—%:-shal b cvs.ncsa.uiuc.edu
L6} >calcc 1.1
| copy.c 1.1
[K) decs.h 1.3

28 void calcuvzh(jstart,jend,p,u,v,cu,cv,h,z, fsdx, fsdy)
291int jstart,jend;

31

) float p[n][m];
float u[n][m];

32 float v[n][m];

1

float cul[n][m];

| float cv[n][m];
float h[n][m];

» float z[n][m];
"float fsdx, fsdy;

8 {

int  1,3,1ip,Jp;

10 /*

41

* Added a comment here

12 %/

for(j=jstart;j<=jend;j++) {

ip = (3+1) % n;

for (1 = 0; 1 < m; 1+4){
ip = (i+1) % m;
cul310ip] = 0.5%Cp[310ipl+p (310D *u31[1p];
evlipl[i] = 0.5*Cp[ip][11+p (3101 D*v[5p][1];
z[jpllip] = (fsdx*(v[jpl[ip]-v[ip][11)-Ffsdy*(ulipllir]

-u[310pd2)/Cp (310 +p (3] 0ip]+p (G [ip]+p (3] [11D);
h[310] = p[3101+@.25*Cul3I[ip]*u (3] 0ip]+u 301 ]*u[3I1]
+v[3pl[1I*v[Gp] [1+v3I0I*vIGI0ID);
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View Changes

Right-click on “calc.c” and
select Compare
With>Latest from HEAD

Compare editor will open
showing differences
between local (changed)
file and the original

Buttons allow changes to
be merged from right to

left

Can also navigate between
changes using buttons

€] cale.c &0 calc.c R
I&, C Compare

|.c® Translation Unit
+® calcuvzh
e calcuvzh
€0 cu
e v
@0 fsdx
€0 fsdy

I&, C Compare Viewer ¥

Local File 1.1

Rl S R )
32 float v[n][m];
33 float culn][m];
34 float cv[n][m];
35 float h[n][m];
16 float z[n][m];
37 float fsdx, fsdy;
38 {
int  1,3,ip,Jp;
10 /*
11 * Added a comment here
2| */
for(j=jstart;j<=jend;j++) {
ip = (3+1) % n;
for (i = @; 1 < m; 144){
ip = (1+41) % m;

cul310ip] = @.5*(p[3][ipJ+p[3I1010D*ul3](]

cvlipl[i] = @.5*(p[ipI[iJ+p[3ILLID*v ip]

zDrllie] = e E e Lhed v Pl )oh

tools platform

_——
w53\
—_——

® |Remote File 1.1
30 float p[n][m];
31 float u[n][m];
32 float v[n][m];
33 float cul[n][m];
34 float cv[n][m];
35 float h[n][m];
36 float z[n][m];
37 float fsdx, fsdy;
28 {
39 int i,3,1ip,Jp;

11 for(j=jstart;j<=jend;j++) {
ip = (G+1) % n;
for (1 = @; 1 < m; 144){
ip = (i41) % m;
cul310ip] = 0.5*(p[jI[ipd+p[II[i1D*u
evl[ip][i] = 0.5*Cp[ip][11+p[3I1[1]D*v
z[jpllip] = (Fsdx*(v[jpl[ip]-v[jip][i]

Pt Bt B T WP N o N e BN o BtV BN o)
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Revert To The Latest Version

+ Right-click on the “shallow” project and select
Replace With>Latest from HEAD

+ Review the resources that will be replaced,
then click OK

Overwrite Uncommitted Changes

The selected elements contain uncommitted changes that will be overwritten.
Should the replace proceed?

@

The following elements contain uncommitted changes that will be overwritten.

Changes
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MPI Features
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MPI-Specific Features

+ PTP’s Parallel Language Development Tools (PLDT) has
several features specifically for developing MPI code

+ Show MPI Artifacts

+ Code completion

+ Context Sensitive Help for MPI
+ Hover Help

+ MPI Templates in the editor

+ MPI Barrier Analysis
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Show MPI Artifacts =

+ In Project Explorer, select a project, folder, or a

single source file
+ The analysis will be run on the selected resources

S e | e Ct S h ow M P I o C/C++ - shallow/mains="Ciipse - [Users/beth/ews/testptp
- Fiv 5 | @ 685 [ G~ v D v s Nr= Y [@3CVS Reposit... »
Artifacts TR 10} Je 00 sun @

L7 Project Explorer 23 » ¢ main.c 53 k @ M |§—] 7 =8

Ru N th e a n a |y5is by > 5 Hellowp A ‘if}‘tat vold_sta ¥ Show OpenMP Artifacts LR 0%
. ] on (s int te; | ui MPI Barrier Analysis R
clicking on drop- -
down menu next to

the analysis button

wimitcarge, | Show UPC Artifacts
Wi Comonion ' Show LAPI Artifacts
if ( proc_ent < 2 )

fprintf(stderr, "must have at leas

MPI_Finalize(Q);
return 1;

<4
VVVVVVVVVVVH,-\

}

if ( (n % (proc_ent - 1)) 1=0 )
{
if ((tid == 0)

[ Problems | = Tasks | E] Console | =] Propel
Artifact

Works on local and e b=

} COPYING 1.1

= j depcomp 1.1
remote I eS JINSTALL 1.1 nalize
jinstall-sh 1.1 W MPI_Barrier

i ) ain.
|} Makefile.am 1.1 a e — - ]
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MPI Artifact View

Markers indicate the
location of artifacts in
editor

The MPI Artifact View
lists the type and
location of each artifact

Navigate to source code
line by double-clicking
on the artifact

Run the analysis on
another file (or entire
project!) and its
markers will be added
to the view

Click on column
headings to sort

Remove markers via

:‘ aclocal.m4 1.1
JAUTHORS 1.1

} Makefile.am 1.1

C/C++ - shallow/main.c - Eclipse - /Users/beth/ews/testptp

float vold_start[m];
int proc_cnt;

int tid;

MPI_Datatype * res_type;

MPI_Init(&argc, &argv);
MPI_Comm,_size(MPI_COMM_WORLD, &proc_cnt);
MPI_Comm_rank(MPI_COMM_WORLD, &tid);
if ( proc_ent < 2 )
fprintf(stderr, "must have at leas
MPI_Finalize(Q);
return 1;
}
if ( (n % (proc_ent - 1)) =0 )
if ((tid == 0)
|2 Problems | | Tasks | E] Console | = Properties » MPI Artifact View 23
Artifact

e ‘}\\\

Y @2 CVS Reposit...  »

o x\ @M ET =0

AR o %
1 math.h

= mpi.h

Pl stdio.h

® decs.h

++ worker() : void

++ setup_res() : MPI_Datatype
° i , char*(])

® setup_res() : MPI_Datatype
@ update_global_ds(MPI_Dat:
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MPI Editor Features

Cgmaineds Eeeasaaemis +  Code completion will show all
float  vold_start[n]; : 1% R N the possible MPI keyword

int proc_cnt;

int tid; [ math.h completions

MPI_Datatype * res_type; = mpi.h

M stdio.h + Enter the start of a keyword

MPI_Init(&argc, &argv); decs.h

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt); . o then press <Ctr|—space>

MPI_Comm_rank(MPI_COMM_WORLD, &tid); + setup_res( : MPI
MPI_B] e main(int, char*(]
MPI_Barrier(MPI_Comm ) int + Blocks each task until all tasks have called it. |
MPI_Bcast(void*, int, MPI_Datatype, int, MPI_|

MPI_Bsend(void*, int, MPI_Datatype, int, int,

MPI_Bsend_init{void*, int, MPI_Datatype, int,

MPI_Buffer_attach( void*, int) int ‘

MPI_Buffer_detach( void®, int *) int [} main.c 53
MPI_Barrier(MPI_Comm comm) : int float vold_start[m];
MPI_Bcast(void * buffer,int count,MPI_Dataty int proc_cnt;
MPI_Bsend(void * buf,int count,MPI_Datatype .| int tid;

MP] _Bsend _init{void * buf.int count.MPI Datz * MPI_Datatype * res_type;

[

if. ()
{

e B B

-
-
~

()
(]
(]
(]
(]
} -]
(]
L]
L]
®

A

Press '~ ' to show Template Propos ./ MPI_Init(&argc, &argv);
MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);
MPI_Comm_rardk(MPI_COMM_WORLD, &tid);

+ Hover over MPI
Prototype: int MPI_Comm_rank(MPI_Comm, int *)

Description:
A PI Returns the rank of the local task in the group associated with a communicator.!" |

b

Press 'F2" for focus

return 1;

}

+ Displays the
function prototype A0 e o socsen - 1. ok
and a description ’
Module 3
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Context Sensitive Help

Click mouse, then press help
key when the cursor is within a
function name

+ Windows: F1 key

+ Linux: ctrl-F1 key

+ MacOS X: Help key or

Help»Dynamic Help

A help view appears (Related
Topics) which shows
additional information
(You may need to click on MPI
API in editor again, to
populate)

Click on the function name to
see more information

Move the help view within your
Eclipse workbench, if you like,
by dragging its title tab

Module 3

PI_Comm_ranl
Protoype: int MPI_Comm_rank(MPI_Comm, int *)
iDescription:
Returns the rank of the local task in the group associated with a com

.

Related Topics

+ About

Click below to see help. .
Some special

info has been
added for MPI
APIs

See also:
B Editor view click here
&l int MPI_Comm_ran\MPI_Comm, int *)

sParallel D

@ Help £3

Contents

@&l 4o

Related Topics C.I,U Bookmarks [ Index

MPI_Comm_rank
NAME

MPI_Comm_rank — Determines the rank of the
calling process in the communicator.

5 Search
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MPI Templates

+Allows quick entry of common patterns in MPI programming

+ Example:
MPI send-receive
+ Enter:
mpisr <ctrl-space>
+ Expands to a send-receive
pattern
+ Highlighted variable names
can all be changed at once
+ Type mpi <ctrl-space> <ctrl-
space> to see all templates

- mpiif - MPI_Init and Finalize
-| mpisr - MPI Send Receive

MPI_Comm_rank(MPI_COMM_WORLD, &rank);
MPI_Comm_size(MPI_COMM_WORLD, &p);
if (rank == @8){ //master task
brintf("Hello From process @: Num processes: %d\n",p);
for (source = 1; source < p; source++) {
MPI_Recv(essage] 100, MPI_CHAR, source, tag,
MPI_COMM_WORLD, &status);
printf("%s\n",message);
}
}
else{ // worker tasks
/* create message
sprintf(message, "Hello from process %d!", my_rank);
dest = 9;
/* use strlen+l so that '\@' get transmitted */
MPI_Send(message, strlen(message)+1l, MPI_CHAR,
dest, tag, MPI_COMM_WORLD);

*/

Add more templates using Eclipse preferences!
C/C++>Editor>Templates
Extend to other common patterns




MPI Barrier AnaIyS|s

= C/C++ - MyBarrier/src/MyBarrier.c - Eclipse SDK - C:\ews\runtime-cdt40

paratieltools plat

File Edit Refactor Source Statistics Navigate Search Project Run Window Help

010

L5 Project Explorer &3

= g_—'f MyBarrier
#-[a)Y Indudes
=3 src
+ Déj MyBarrier.c
+- (= Debug
3 Uc MyCproject
# x5 MySampleProject

/7, MP1 Barriers %

Function

Barrier

G- aiv [ @

=0 |.€] matrixio.c

=
=

H- Q- Q-

€] zzzzTemplateTest.c &) MyBarrier.c &2

if (my_rank !=0)({

sprintf (message,
dest = 0;

"Greetings from process

I-IPZ_Ser.d(rressage strlen (rressace]
dest, tag, MPI_COMM WORLD):
MPI Barrier (MPI_COMM WORLD):
}
else{
printf ("From process 0:
for (source = 1; source < p; source++) {
MPI_Recv(message, 100, MPI_CHAR,
MPI_COMM WORLD, &status):;
printf ("$s\n",message);
}
MPI Barrier (MPI COMM WORLD) ;
Barrier():
3

< >

{2 Problems | v Tasks | £l Console "/ Barrier Matches 3 =0

=0

Num processes: d\n'

source,

Ov

B | c/c++
L Resource

5= outline 52

AN

H stdio.h

™ string.h

™ mpi.h

@ Barrier() : void

@ main(int, char*[]) : int

v

/4 Barrier Errors &%

i ¥ Barrier Matching Set

LineNo |
MyBarrier.c 8
MyBarrier.c 8
MyBarrier.c 41
MyBarrier.c 31
MyBarrier.c 31
MyBarrier.c 41
MyBarrier.c 8
MyBarrier.c 41
MyBarrier.c 57
MyBarrier.c 62

Barrier Matching Set Function Filename
=W Barrier 1(2)
Wi Barrier 1
77 Barrier 3
=W Barrier 2 (1) main
/i Barrier 2 main
=W Barrier 3 (2) main
i Barrier 1 Barrier
i Barrier 3 main
/4 Barrier 4 (0) main
+- W Barrier 5 (1) main

Barrier
Barrier

=" Error
+- W Path 1 (1 barrier(s))

7 path 2 (0 barrier(s))

=" Error
+- " Loop (dynamic number of barriers)

“E‘MakeTargets =0

B RN e

i v =5

Function

main

Local
files only

Verify barrier
synchronization in C/
MPI programs

Interprocedural static
analysis outputs:

+For verified programs,
lists barrier statements
that synchronize
together (match)

+ For synchronization
errors, reports counter
example that illustrates
and explains the error




parallel—tools platform

au ‘,}\\\

MPI Barrier Analysis — Try it

Run the Analysis:

+ In the Project
EXplorer, select the 7 A shallow s

L6} calc.c 1.1

project (or directory, B comrc 1.1
or file) to analyze R decs.h 1.3

Lf} diag.c 1.1

L[ Project Explorer &3

+ Select the MPI M 51 5. % o

Barrier Analysis > Show MPI Artifacts
action in the pu”— ¥ Show OpenMP Artifacts

down menu /// MPI Barrier Analysis
% Show UPC Artifacts
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MPI Barrier Analysis — Try It (2) =

+ No Barrier Errors are found (no pop-up
indicating error); Two barriers are found

® Eclipse File
e NO

Edit Source Refactor Navigate Search Project Run Window Help

'c| C/C++ - shallow/main.c - Eclipse - /Users/beth/ews/
0 Q- Q| &S & @1 O &5

@‘v[ﬂv c;';v Gv 6&' ;&3'

= 8| [c] main.c 53

= 83 MPI_Finalize();
! return 1;

= | lone
L{*5 Project Explorer 23

A,
=5 shallow [cvs.ncsa.uiuc.edu] ac }
| calc.c 1.1

|7} copy.c 1.1
[Kl decs.h 1.3
|} diag.c 1.1

[} dump.c 1.1

) Includes
|} init.c 1.2
[.7) main.c 1.4
[} time.c 1.2
[} tstep.c 1.1

| worker.c 1.2

Afj aclocal.m4 1.1

| AUTHORS 1.1

4 Changelog

1.1

3 compile 1.1

) config.guess 1.1

if (tid !'= @) {
worker();
MPI _Barrier(MPI_COMM_WORLD);
MPI_Finalize();

} else {

/* master process *

1 - - - d £ enm = ==d

/i MPI Barrier Matches | /7 MPI Barriers 23

Filename LineNo IndexNo
main.c 89 1
main.c 206 2

Function
7 main
/i main




paratieltools platform

MPI Barrier Analysis - views .

//i MP1 Barriers £ = O ||[2. Problems | v:| Tasks | &l Console | " Barrier Matches 2 = O || %4 Barrier Errors 3 i ¥ =08

i - i v Barrier Matching Set Function
=" Error main
+-W Path 1 (1 barrier(s))
i Path 2 (0 barrier(s))
=W Error main
+-" Loop (dynamic number of barriers)

Function Barrier Matching Set Function Filename LineNo |#
'Iltju P | r— — . S —
i main i Barrier 1 Barrier MyBarrier.c 8
W main 4 Barrier 3 main MyBarrier.c 41
#h  main =)W Barrier 2 (1) main MyBarrier.c 31
" main /i Barrier 2 main MyBarrier.c 31
Barrier = Barrier 3 (2) main MyBarrier.c 41
7 Barrier 1 Barrier MyBarrier.c
/i Barrier 3 main MyBarrier.c 41
¥4 Barrier 4 (0) main MyBarrier.c 57
+- W Barrier 5 (1) main MyBarrier.c 62

MPI Barriers view Barrier Matches view Barrier Errors view
Groups barriers that

match togetherin a
Like MPI Artifacts view, parrier set — all counter-example

double-click to navigate processes must go shows paths with
to source code line (all  through a barrier in the ~ MiSMatched number

Simply lists the barriers If there are errors. a

3 views) set to prevent a of barriers

deadlock
Module 3




paratieltools platform

-u ‘,}\\\

Barrier Errors

+ Let’s cause a barrier mismatch error

+ Open worker.c in the editor by double-clicking
on it in Project Explorer

+ At about line 125, 0 ey = werker PRED:

t = worker[NEXT];
jstart = worker[JSTART];

enter a barrier: S Jend - werker WD)
+ Type M PI_B . :| t ~ © MPI_Barrier(MPI_Comm } int Blocks each task until

r "C'i'l @ MPI_Bcast(void*, int, MPI_Datatype, int, MPI_
+ H It Ctl i S pa Ce "" */ @ MPI_Bsend(void*, int, MPI_Datatype, int, int,
N o for @ MPI_Bsend_init{void*, int, MPI_Datatype, int,
M ® MPI_Buffer_attach( void*, int) int

+ Se I ect M PI_Ba rner @ MPI_Buffer_detach( void*, int *) int

+ Add communicator
arg MPI_COMM_WORLD and closing semicolon

MPI_Barrier(MPI_COMM_WORLD);
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Barrier Errors (2)

+ Save the file
+ Ctl-S (Mac Command-S) or File > Save
+ Tab should lose asterisk indicating file saved

+ Run barrier analysis on shallow project again

+ Select shallow
project in Project O~

g ¥ Show MPI Artifacts
Explorer first ¥ Show OpenMP Artifacts

/// MPI Barrier Analysis
% Show UPC Artifacts
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Barrier Errors (3)

MPI Barrier Analysis

* Ba rrier‘ Error iS found ' Found barrier synchronization error(s)!
+ Hit OK to dismiss dialog o

+ Code diverges on line 87
+ One path has 2 barriers, other has 1

/7, MPI Barrier Matches "#i MPI Barriers |"//) MPI Barrier Errors 23 B P Dou ble—CI ICk

on a row in
Barrier Matching Set Function Filename ineNo IndexNo B . E
/i Errg main main.c @ 0 arrier errors
f//iPath 1 (2 barrier(s)) 0 view to find
#/iBarrier 1 main main.c 89 g :
fliRarric worker  worker.c the line it

0 references in
if/iBarrier ¢ main.c the Code

3-53
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Fix Barrier Error =t

l.c] worker.c 23 €| main.c

+ Fix the Barrier Error jg
before continuing |

+ Double-click on the | e

Barrier Matching Set Function Filgname LineNo IndexNo

#/iError main i 0

ba rrier in Worker.c f7iPath 1 (2 barrier(s))

f/iBarrier 1 main

to quickly navigate T -

#/iPath 2 (1 barrier(s))

to it /i Barrier 2

+ Remove the line and save the file
_Or_
Right mouse on worker.c in Project Explorer
and do Replace With > Latest from HEAD

Team

Compare With
Replace With Latest from HEAD

% Run C/C++ Code Analysis Arlother Branch or Version...
History...
Properties Previous from Local History
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Remove Barrier Markers =

+ Run Barrier Analysis again to remove the error
- and/or -

+ Remove the Barrier Markers via the “X” in one
of the MPI Barrier views

'//) MPI Barrier Errors £3 i 6 = 0O

Barrier Matching Set Function Filename LineNo
#/iError main main.c 87
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Synchronizing the Project
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Synchronizing the Project

+ Because we will be running on a remote
system, we must also build on that system

+ Source files must be available to build

+ We will use a synchronized project to do this
+ Only needs to be done once for each project
+ A synchronized project could have been created
initially
+ Files are synchronized automatically when
they are saved

+ A full synchronize is also performed prior to a
build
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Converting To Synchronized

+ Select File>New>Other...
+ Open the Remote folder

+ S e | e Ct Co nve rt C / C + + o r SZI::::I :ri:ji'::to automatically synchronize project resources
Fortran Project to a
Synchronized Project

4+ Click Next>

Wizards:

(= Ceneral

& Convert C/C++ or Fortran Project to a Synchronized Project
[t Convert to a Remote Project
i, Remote C/C++ Project
[c]] Synchronized C/C++ Project
ESynchronized Fortran Project
[~ Remote System Explorer
(=~ Tasks
(=XLUuPC
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Convert Projects Wizard

Select checkbox next to “shallow”

For Connection:, click on New...

Enter as directed:
+ Target name
+ Host name of remote system
+ Userid and Password

Click Finish to close it
Back in the Convert Projects dialog,

Enter a directory name in the
Location field; select Browse...

+ Sample: /u/ac/trainXX/shallow

+ Project files will be copied under this
directory

Click Finish

eNo Convert Projects

Convert to a synchronized project

Converts a managed or unmanaged project to a synchronized
project by adding a sync nature

Candidates for conversion:

lz‘ =*shallow

Synchronization Provider: | Git ﬂ

Remote Provider: | Remote Tools v
Connection: | forge 4] ( New... )

Location: fu/ac/trainXX/shallow

(" cancel ) € Finish )
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Synchronized Project

+ Back in the Project
Explorer, decorator on
project icon indicates [ Project Explorer &3
synchronized project

+ Double-+ icon
== project
.hallow idev.ec
+ Before sync calc.c 1.2

o5 shallow [dev.eclipse.org ['_r_l COpY.C 1.2
+ After sync

5 shallow [dev.eclipse.org
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Set Active Build Configuration

The “Active” build configuration determines which system will
be used for both synchronizing and building

Right-click on the project and select Build
Configurations>Set Active>Remote (Build on remote
machine)

| v 1 Default
2 Remote (Build on € mote machine)
Index

Synchronization Build All

Clean All [
VahdaFe y ) ) » Build Selected... ,,71_4 Properties| B

| Remote Environments @1 History
|y

The project should synchronize immediately

Remote Synchronization: (46%)
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Building the Project
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Building the Project |

+ Select the project in Project Explorer, click on the
hammer button to run the build Bt

L[ Project Explorer &3 =4 = | & 65~ & @ 3. H O Q- Qv | @ O-

| calc.c 1.2 ‘ |
.f} copy.c 1.2
+ By default, the Build Configuration assumes there is a
Makefile (or makefile) for the project

+ In this case, there is no Makefile,
SO the bUIId WI” fail- ‘" Problems | ¥ Task £ Properties | [ Remote Environ

See Console: CDT Build Console (shallow

We'll see how to change it if the build
command is different from mate all o o ) 0 e

. 1 ¥ ru to make target “all'. top.
‘make —f Makefile’ rake o e

**¥¥ Build of configuration Remote for project shallow ****

¥ ¥ Build Finished ****

Module 3
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Fixing the Build Command: =9
Editing Project Properties

The build command is specified in the project properties

Open the properties by right-clicking on “shallow” and selecting
Properties (bottom of the context menu list)

Click on C/C++ Build
Uncheck Use default build command
Enter “make -f Makefile.mk” in the Build Command field

Click OK to close O Properties for shallow
project properties :
dla|Og Resource

Builders ; - .
C/C++ Build Configuration: | Remote [ Active )

Build Variables
Discovery Options

C/C++ Build

Environment
Logging
Settings : Builder

Synchronize

Tool Chain Editor Builder type:

XL C/C++ Compiler -
C/C++ General |} Use default build command
Cvs
Discovery Options
Environment

Build command: make -f Makefile.mk
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Re-Building the Project

+ Click on the B¥ button again to run the build
+ Build output will be shown in the Console view

‘E'j'_ Problems \/— Tasks El Console 23 =) Properties Eb Remote Environments 51 History
CDT Build Console [shallow]
main.c:97: error: syntax error before ':' token

main.c:97: error: syntax error before ')' token
main.c: At top level:

main.c:212: error: syntax error before "return"
make: *** [main.o] Error 1

¥¥¥¥% Build Finished *¥**

+ Exact output depends on your compiler
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Build Problems

| | C/C++ - shallow/main.c - Eclipse - /Users/greg/Documents /workspace
o | & &l [y @~ v [ 0 [ 55 Egc/c++ [yResource E0Team Synchr... £ Parallel Debug
L5 Project Explorer &2 = 0| [4 cale.c g€l main.c & = 0| 5% out % @ Mak =08
] i i |- g
= if Ctid 1= 0) { BV o %7

worker();

+ Build problems will be (S R W o

g} calc.c 1.1 ) MPI_Finalize();
[} copy.c 1.1 31 } else { stdio.h

shown in a variety of 3 ri

|.¢ diag.c 1.1 /* master process */ -+ worker() : voic

WENE B 1 + | el s
) chunk_size = n / (proc_cnt - 1); main(int, char*(])

[n) Includes

H L init.c 1.2 y for (i = 1: i R L) 4 setup_res() : MPI_Datatype
+ Marker on file {) main.c 1.4 \ - : calcu?a:cngzhc:orkz:t boundary */ update_global_ds(MPI_Dat:
. . iz "z y master_packet[JSTART] = (i - 1) * chunk_size;
Marker on editor line i tstepc L1 1
yoTRer.c 1.2 101 if (i == proc_cnt -
3 2 - o > . 1 ma =pUCket [JEND] = n - 1;
Line is highlighted g aciocalmd 1.1 - T

AUTHORS 1.1 . .
JCha master_packet[JEND] = i * chunk_size - 1;
. arlas

Marker on overview ruler omoiie 1.1 o SR
n q j config.guess 1.1 1 rv = proc_cnt-1;
Listed in the Problems Jconfohin 1. ctse
- 3 config.sub 1.1 109 prv = i-1;
VIeW j configure 1.1 11¢
Af configure.ac 1.1
COPYING 1.1
H¥gpcomp 1.1 11
§INSRQLL 1.1 11 else
Jinstall~ag 1.1 11¢ nxt = i41;
A Makefile.al
) Makefile.in 1 118 master_packet[NEXT] = nxt;
(yMakefile.mk 1.1

master_packet[PREV] = prv;

if (i == proc_cnt - 1)
nxt = 1;

: )

p missing 1.1 /5. Problems £3 | Tasks | ] Console| =] Properties | [ Remote Environments | & History

+ Double-click on line in it
= A Resource Path Location
H @ Errors (3 items)
Problems view to go = st eor b token o maine——Dshalow———line 7 lc/cos obienl —
@ syntax error before )' token main.c /shallow line 97 C/C++ Problem

to I 0 Ca ti O n Of e rro r i n € syntax error before "return" main.c /shallow line 212 C/C++ Problem
the editor

syntax error before "' token

Module 3
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Fix Build Problems

Fix errors by changing *:" to *;" on line 97

Save the fl Ie |h| decs.h l.€] copy.c l.c|] diag.c L] main.c &3 .| worker.c
RebUIId by preSSing bUIId ;hunk:s-;ze —-n';)(proc_cnt - 1);

bUtton for (: ;aléLlla:Lngzac?:’Lz+Tz tEx:nundar‘y */
Error markers have been [

master_packet[JSTART] = (1 - 1) * chunk_size;

if (1 == proc_cnt - 1)

removed master_packet[JEND] = n - 1;

else

master_packet[JEND] = i * chunk_size - 1;

Check console for Corract |
build output . problems [ 71 Tasks 2 console 3

CDT Build Console [shallow]

**¥¥ Build of configuration Remote for project shallow ****

make -f Makefile.mk all

mpicc -g -c -o main.o main.c|

mpicc -g -c -0 time.o time.c

mpif99 -g -c -o tstep.o tstep.f90

mpicc -g -c -o worker.o worker.c

mpicc -g -c -0 dump.o dump.c

mpicc -g -0 shallow calc.o copy.o diag.o init.o main.o time.o tstep.o worker.o du

*¥¥¥x Build Finished ****
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Forcing a Rebuild

+ If no changes have been made, 47 Problems | 8 Tasks | B console 3
/ . . - CDT Build Console [shallow
make doesn’t think a build is needed

+ Project > Clean... —
+ Select your project

Close Project

make -f Makefile.mk all
make: Nothing to be done for “all'.

010 Build All
Build Configurations
Build Project
Build Working Set
Clean will discard all build problems and built states. The — Clean...

projects will be rebuilt from scratch. v Build Automatically
i

e . -
) Clean all projects ® Clean projects selected below
— pro} O pros Make Target b

™ =S shallow
Prepare Changelog ~XP

Properties

( cancel ) OK )

L )
+ S ee CO n SO | e {2 Problems | ¥ Tasks | El Console &3
CDT Build Console [shallow]

*¥¥* (lean-only build of configura

+ Then rebUiId make -f Makefile.mk clean

rm -f shallow calc.o copy.o diag.o

Module 3
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Running the Program

Resource Managers
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Running the Program

+ Creating a resource manager

+ Starting the resource manager

+ Creating a run configuration

+ Running (launching) the application
+ Viewing the application run

Much of the following setup is
@ configuration that you only need to

do once: This icon will remind you.

Do this
once
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Resource Managers

+ PTP uses the term “resource manager” to refer to any
subsystem that controls the resources required for
launching a parallel job.

+ Examples:
+ Batch scheduler (e.g. LoadlLeveler, PBS, SLURM)

+ Interactive execution (e.g. Open MPI, MPICHZ2,
etc.)

+ Each resource manager controls one target system
+ Resource Managers can be local or remote
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Monitoring/Runtime Perspectives

+ Parallel Runtime Perspective
+ Used for legacy PTP Resource Managers

+ System Monitoring Perspective

+ Used for newer Configurable Resource Managers (since
PTP 5.0)

+ Which one is used?

Resource Manager System Monitoring Parallel Runtime

IBM LoadLeveler (4

IBM Parallel Env

v
MPICH2 4
v

Open MPI

PBS-Batch-Generic

PBS-Batch-Interactive

Remote Launch

SLURM
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Preparing to Launch |

+ Setting up a resource manager is done in the System Monitoring
perspective

+ (For PTP 5.0, this applies to PBS)
+ Select Window>0pen Perspective>Other...
+ Choose System Monitoring and click OK

Hg C/C++ (defau New Window

CVS Repository Exploring
%5 Debug

@Fortran

ﬁjjava

;:\Jjava Browsing

feJjava Type Hierar
ggParallel Debug )
288 parallel Runtime Save Perspective As...

1) Planning Reset Perspective
rT&Remote C/C++
ZE Remote System E
[P Resource Close All Perspectives
2ees System Monitoring

&5 Team Synchronizing NaVigation

X XML

Show View

Customize Perspective...

Close Perspective

Working Sets

\ e Preferences...
( Cancel ) OK K

Module 3
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+ System view ___
+ Jobs running
on system
+ Active jobs
+ Inactive jobs — |FERE
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About PTP Icons

+ Open using legend icon in e
t00|bar (@ STARTING
(#) STARTED
STOPPING
STOPPED
SUSPENDED
ERROR

Machine Icons Node Icons

up up 2 UNKNOWN

—

2 [l DOWN || PROCESS RUNNING
ALERT

ERROR
UNKNOWN

B ERROR |ty PROCESS TERMINATED

Job Icons Process Icons
) STARTING & STARTING
2 RUNNING » RUNNING
() SUSPENDED y SUSPENDED
© COMPLETED « COMPLETED

{ Close )
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Configuring Job Scheduler

+ Right-click in Resource $-0-Q-
Managers view and Py —r— = )l Syt ioitr
select Add Resource 2 CpenPiGlincen CpentiFl
Manager Y

P Start Resource Manager

= Stop Resource Manager

288 [nactivese
Add Resource Manager...
Remove Resource Manager

Edit Resource Manager

Set Default Resource Manage

v

+ Choose Resource

Manager Type: ety ot o g
edu.illinois.ncsa.forge

IBM LoadLeveler

.pbs.batch.openmpi el i

Open MPI

Open MPI-Generic-Interactive
PBS-Generic-Batch
PBS-Generic-Interactive

Remote Launch

SLURM
edu.illinois.ncsa.forge.pbs.batch.mvapich2

edu.utk.nics.keeneland.pbs.batch

+ S e | ect N ext > edu.utk.nics.kraken.pbs.batch
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Configure Control Connection

+ Choose Remote Tools for Remote service provider
+ Choose the remote connection you made previously Do this

+ Click Next> onee

Control Connection configuratioy

Enter connection information

Remote service provider: | Remote Tools
Connection name:

» Advanced Options
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Configure Monitor Connection

+ Keep default Monitor Connection (same as Control Connection),

click Next

Do this

Monitor Connection configuration once

Enter connection information
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Common Configuration

+ Keep default name
+ Can automatically start Resource Manager (leave unselected

today)
+ Click Finish

Common Resource Manager Configuration Do this
(o]p[eS

Change any settings for the resource manager

Name and description

@ Use default name and description:
Name: PBS-Generic-Batch
Description: XML Configurable Resource Manager

Startup
") Automatically start resource manager when Eclipse starts

( cancel ) € Finish */
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Starting the Resource Manager

+ Right click on new
@ Resource Managers &3 = [

resource manager and S Ty
‘ — — '—
select Start resource e ™ Siar Resource Manager gy

mManager ] Stt'p Resource Manager

If everything is ok, Add Resource Manager...

you should see the Remove Resource Manager
resource manager change [ i ==
to green . {  Set Default Resource Manager

If something goes wrong,

it will change

to

(+) Resource Managers 53 (+) Resource Managers 3
(7. PBS-Generic-Batch (LML_JAXB) ¥, PBS-Generic-Batch (LML_JAXB)
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System Monitoring =

forge.ncsa.illinois.edu

|| System Monitoring - shallow/Makefile.mk - Eclipse - /Users/beth/ews/test1027-sc11-tutorial

System view, with
abstraction of nodes

If;gl) f nse lected Resource | ’\Se(IeJAcX:’)c Resource Managg
anager %mmﬁmM%%%%

Active and inactive jobs

Hover over node in
System view to see job DDDDDDD
running on node in : — ’ DDDDDDD

Active Jobs view | s e A DDDDDD

]
W 3
|
o 3
= 3
N 3
|
= 3
O 3
]
| ]
W 3
W3

make -f Makefile.mk all
icc -g -c -0 calc.o calc.c

Hold mouse button
down on a job in Active One node with
Jobs view to see where 16 cores
it is running in System
view
Module 3
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Running the Program

(Launching a Job)
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Create a Run Configuration '7

once

= Run Configurations -®

Create, manage. and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

’ ‘ - 3 v Configure launch settings from this dialog:
Run Conﬁgurations ype filter text Y - Press the 'New' button to create a configuration of the selected type.

" - k [c] C/C++ Application =| - Press the 'Duplicate’ button to copy the selected configuration.
Organize Fayorites..) [¥] Fortran Local Applica

@ Launch Group

¥ - Press the 'Delete’ button to remove the selected configuration.
5=} Parallel Application 33

1 - Press the 'Filter' button to configure filtering options.

+ Open the run configuration
dialog Run>Run
Co nfi g u rati o n s . Configure launch perspective settings from the Perspectives preference page.

Select Parallel Application
Select the New button .

’ - Edit or view an existing configuration by selecting it.

Or, just double-click on ‘ ]
- - Filter matched 4 of 4 items

Parallel Application ;

to create a new one @

Depending on which flavor of Eclipse you Note: we sometimes

: : : : interchange the terms
installed, you might have more choices in TR Cor e e e

Application types “Launch Configuration”
Module 3 3-83
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Complete the Resources Tab . -

Do this
once

E n te r a n a m e fo r th i S ru n :eaterr:anage and run configurations B

CO n fi g u ra ti O n s/ e . g . Create a configuration to launch a parallel application
“shallow-pbs-batch”

M X | = : A Name: _ shallow-pbs-batch
I n Reso u rces ta b , Se I ect : filter text Application | (9= Arguments | I Environment | Synchronize | =] Common
th e P B S re SO u rce m a n a e r :&JE/C*‘ fppll\iﬂ\olﬁ ) Resource Manager: | edu.illinois.ncsa.forge.pbs.batch.openmpi
F | Fortran Local Application )
. g J;‘a Applet
you just created e
= P
d 2 I I o o f Eﬁ Parallel Application
(e U . I I n 0 I S . n Csa . 0 rg e T ) §=% shallow Job Name: [ otp_job " The name assigned to the job by the gsub or galter commg
Select the d esti nati O n Account: Account to which to charge this job.

q u e u e — d e b u g ‘) Queue: debug S Designation of the queue to which to submit the job.

. Number of nodes: 1 & " Number and/or type of nodes to be reserved for exclusive
The MPI Command field ,

Total Memory Needed: 7 Maximum amount of memory used by all concurrent proce
allows this job to be run

a S a n M PI j O b MPI Command: mpirun 4] Which mpi command to use.

* Ch Oose m pi ru n MPI Number of Cores: 4 &'? the '-np' value

E n te r. th e r.e S O u rces Export Environment: | @ All variables in the gsub command's environment are to be
needed to ru n th iS job { View Script ) ( View Configuration ) Restore Defaults )

+ Use 1 nodes, 4 cores (MPI
tasks) Revert )

Filter matched 7 of 7 items

{ Basic PBS Settings Advanced PBS Settings Import PBS Script

Name Value Description

Wallclock Time: "00:05-00 7 Maximum amount of real time during which the job can be

@
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Complete the Application Tab i~

Select the Application
tab

Choose the Application
program by clicking the
Browse button and
locating the executable on
the remote machine

+ Use the same “shallow”

executable

Select Display output
from all processes in a
console view

Click Run to submit the
application to the job
scheduler

Do this
once

Run Configurations

Create, manage, and run configurations

| Create a configuration to launch a parallel application \l/))

~»l,.
| X | B Se- Name: ' shallow-pbs=h
text &= Resourcffs | [£] Application ) (9= Arguments | Fi§ Environment | Synchronize | =] Common

[C]C/C++ Application Parallel Project:

[F|Fortran Local Applicatit

Java Applet

Java Application Application program:

@ Launch Group

53} Parallel Application
5} shallow

shallow . Browse )

Juf/ac/tibbitts /shallow/shallow ( Browse |

[T Copy executable from local filesystem

Path to the local file:

play output from all processes in a console view

> -

| | Filter matched 7 of 7 items

@
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Job Monitoring

| | System Monitoring - shallow/Makefile.mk - Eclipse - /Users/beth/ews/test10

5 '::_}v Ov(/;‘v et ! SR v - Y i System

JOb initia”y appears in ‘.;-)‘esourceManagerssg system: forge.

“Inactive Jobs”, then in S s E Dﬂﬂﬂ
“Active Jobs”, then returns to YR T rm—— i
Inactive on completion 5 B e e (I
This short-running program ﬁmﬁmmmﬂ__nw nnnnnmn
may not run long enough to

appear in “Active Jobs”

Status refreSheS 0 ;:26f ched gopal  debu sgo 2;?;8 ;?is e m“; ;J;:mw
. [:] 3627f ched g p ebu 600 2011... ? TS.LIBM-ITE_D_

automatically every 60 sec 77

Or force refresh with menu

After status = COMPLETED,

Can view output or error by S ot ob Elor
right clicking on job, selecting £ Get Job Output
appropriate output "> Refresh Job Status U

¥ Remove Job Entry

Module 3




Job Output

+ After status = COMPLETED,
Can view output or error by
right clicking on job, selecting
appropriate output

+ Output/Error info shows in
Console View

¢ Inactive Jobs £3

step owner
3626.fsched gopal

3627.fsched gopa

alberto
dsouth
tibbitts
tibbitts

3769.fsched
3774.fsched
3772.fsched
[ 3773.fsched

queue
debug
debug
normal 43...
normal

=8

wall queuedate dispatc¢ total¢ status
600 2011-1... 7
600 2011-1... 7
2011-1... 7
14.../2011-1... |?

? SUBMITTED
? SUBMITTED
18 SUBMITTED
12 SUBMITTED
? COMPLETED
? COMPLETED

m:m-mmm_-——'m

[0 3783.fsched

Console &2 ) £l Properties | .

tibbitts

debug

0

Problems | ¥ Tasks

ptp_job.03777

Potential energy
Total Energy

Cycle number 950
Potential energy
Total Energy

Cycle number 1000
Potential energy
Total Energy

6.505 Kinetic Ener‘;
48032.016 Pot. Enstropl

Model time in days 9.9
760.460 Kinetic Enery
48385.996 Pot. Enstropl

Model time in days 1.0
21561.933 Kinetic Energy
48000.496 Pot. Enstrophy

Resume Job
Cancel Job
Hold Job
Release Job
Suspend Job

2| Get Job Error

a Get Job Output

2! Refresh Job Status

¥ Remove Job Entry
ZU9359.9035 | 4 ﬂ
1.805456e-27 O
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Building before Run

Do this
once

To bring up Preferences dialog,

+ If projects build prior use Window>Preferences or
tO Iaunch YOU can Mac: Eclipse>Preferences

! Preferences

tu rn it Off- type filter text Launching f

Ceneral

‘ G O i nto C/C++ Save required dirty editors before launching
Changelog () Always () Never ® Prompt
Fortran

P refe re n Ces > Ru n / Help Wait for ongoing build to complete before launching

Install/Update

Debug and click on Java

Library Hover Launch in debug mode when workspace contains breakpoints

@ Always ; Never ’; Prompt

Mylyn

-
Launching. O Avays @ Never O prompt
Remote Systems .
Continue launch if project contains errors

1 - = Remote Tools
+ U nCh eCk Bulld (If Run/Debug ::: Always @ Prompt
- d b f Console
errraTOT General Options
requived) before B
- ” ~— - ] = BUild (if required) before launching
Ia u n C h I n g String Substitution [Z‘ Remove terminated launches when a new launch is created

View Management
) 9 ™ Prompt for confirmation when removing a configuration from th -
View Performance

Service Configurations v - >
|’? ( cancel ) OK )
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Exercise

+ Start with your ‘shallow’ project

+ Create and start Resource Manager
+ Build; Run shallow

+ See results

+ Change something
+ Change m and n in decs.h

+ Rebuild and re-run
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Advanced Features

Searching

Fortran
Refactoring
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Searching
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Switching Perspectives

hrch  Project Run RULGIUE Help
C/C++ New Window Eclipse SDK
# New Editor

®  Open Perspective > ‘& Debug

+ Switch to C/C++ Perspective s

Customize Perspective... Other...
O n e Of t h ree Wa yS L] Save Perspective As...
L] Reset Perspective...
Close Perspective
. Close All Perspectives

Navigation

1. Choose the Window>Open Finctude ST GpenFerspetEveT|
Perspective menu option = _ |
Then choose Other...

& CVS Repository Exploring
%> Debug
£ PTP Debug

Click on the Open Perspective button in the ol
upper r|ght corner Of (5 Resource

screen (hover over it to L} s

see names . ooo
) ¥ ooo Parallel Runt...

e || cancel |

Click on a perspective
shortcut button
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Find/Replace within Editor

+ Simple Find within editor buffer
+ Ctrl-F (Mac: Command-F)

™ O Find/Replace
Find: pmean|

Replace with:

Direction Scope
® Forward ® Al

() Backward () selected lines

Options

M aoe

| Case sensitive M Wrap search
[} Whole word [} Incremental

[T Regular expressions
( Find ) ( Replace/Find )
( Replace ) ( Replace All )

(  Close )

float ptot,ketot,etot,enstot,ptime,pmean;
int  1,j,ip,Jp;

ptot=0.; ketot=0.; etot-0.; enstot - @.; pmean = 9.;
for (3 = 0; j < n; j++) {
for (1 = 0; 1 < m; i44) {
pmean = pmean+p[jJ][i];
}
}
pmean = pmean/(m*n);
for (3 = @; j < n; j++d{
ip = (J+1) % n;
for (1 = @; 1 < m; 144){
ip = (1+41) % m;
ketot += p[jJ[1]*@.25*Cu[jI[ipI*uliI(ip]+ul3I[1]*u[i]1[1]
+v[ipl [(AI*vlipd (iJ4+v 310 I*v G0 0D;
ptot += (p[jJ[i]-pmean)*(p[j1[i]-pmean);
etot += h[3][i];
enstot += z[jp][ipJ*z[jp]l[ip] * 0.25*%
Cp(3I0J+p (3 0pd+p[Gp] [ipd+p[Gp1[11D;
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Mark Occurrences

(C/C++ Only)

+ Double-click on a variable in the CDT editor

+ All occurrences in the source file are
highlighted to make locating the variable
easier

+ Alt-shift-O to turn off (Mac: Alt-Cmd-0O)

l.c| diag.c 23
AR 3
11 float ptot,ketot,etot,enstot,ptime,pmean;

12 int  1,3,1ip,Jp;

;i ptot=0.; ketot}@.; etot=0.; enstot = 0.; pmean = 0.;
15 for (3 = @; < n; j++) {
. for (i = @; 1 < m; i+4) {
pmean = pmean+p[j][1];
: }
)}
50  pmean = pmean/(m*n);
for (3 = @; j < n; j++d{
ip = (3+1) % n;
for (1 = @; 1 < m; i+4){
ip = (1+41) % m;
ketot += p[j1[1]*0.25*Cu[j][ip]*ul3][ipJ+ul3][1]*u[3]1[1]
wvipl [ *vDplLilwvi ]I VEI )5
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Language-Based Searching

(C/C++ and Fortran)

+ “Knows” what things can ProjectWirclow + E.g., search for every call
be declared in each Sl i to a function whose name
language (functions, T; starts with “get”
variables, classes,

C/C++...
modules, etc.)

+ Search can be project- or
workspace-wide

Fortran...

- Search

— P C1 oo — — - i
15 File Search | ~ C/C++ Search | F)” Fortran Searchlu,y Java Searchl » Plug-in Search| T E

Search string (* = any string, ? = any character):

. . v i File Search %57 C/C++ Search‘ £5” Fortran Search 7 Java Search I p> Plug-in Search‘
get v | | Case sensitive L . ' |

Search pattern:

Search For Limit To ) .

. . . L get” v | ,Regular expression

Class / Struct V| Function | Variable || Declarations | Definitions
. . * - 1 ? =

Union V| Method | Field || References | All Occurrences (* = any string, ? = any character)

Enumeration [] Enumerator [~| Namespace Search for Limit to

Typedef 7] Macro [7] Any Element [7] Commeon block [¥] Function All occurrences

[¥] Subroutine [T Module Declarations

Scope [ Variable [“]Program @ References

@ Workspace Selected resources Enclosing projects
Working set: Scope

@ Workspace Selected resources Enclosing projects

3\ N
'7 Customize...

) o)
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Find References

(C/C++ and Fortran)

+ Finds all of the places where a variable,
function, etc., is used

+ Right-click on an identifier in the editor

+ Click References»Workspace

or References» Project

References > Workspace %G
Search Text Project
Working Set...

Make Targets

MPI_Init(&argc, &argv);

+ Search view :
shows matches [EEEEEERE oty §

if ( proc_cnt < 2 )|

fprintf(stderr, "must have at leas
MPI_Finalize():
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Open Declaration

(C/C++ and Fortran)

Jumps to the declaration of [fEETEEx
a variable, function, etc., 4 _ o

arm ant . . 35 initialise(p, u, v, psi, pold, uold, vold, di, dj, z);
even if it' s in a different 6 diog(1, 0., p, u, v, h, 2

file for (i = 1; 1 < proc_cnt Undo

8+ w—3i_ Revert File
acopy_two_to_onel

MP a ar!

Left-click to select identifier - BAMNe  Open Declaraton =~ F3

acopy_two_to_one/ Open Type Hierarchy

nght‘C“Ck on identifier MPI_Send(&u_sta/'  Open Call Hierarchy
Click Open Declaration

Goes to its declaration
in copy.c
C/C++ only:

Can aISO Ctrl-_C“Ck bcopy(src[column], dest[column], sizeof(src[column]));
(Mac: Cmd-click) on an 60 }

61

identifier to “hyperlink” to 62 acopy_two_to_onel(twodim,onedim,column)
its declaration 63 float  twodim[n] [n];

64 float  onedim[m];
651int column;

L€ main.c .c| copy.c &3
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Search - Try It!

=)

1. Find every call to MPTI Recv in Shallow.

2. In worker.c, on line 42, there is a declaration
float pln] [m].

a) What is m (local? global? function parameter?)
b) Where is m defined?

c) How many times is m used in the project?

3. Find every function whose name contains the
word time
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Fortran Specifics
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Project Properties

+ Right-click Project + Project properties are settings
+ Select Properties... that can be changed for each
.() Project Ex;?r 3 . 44 Remote Systems prOJeCt

=2 >shallo [dev.eclipse.org] 4+ Contrast with
B commc 12 workspace preferences,
—— which are the same
Resource v regardless of what
pan sl . project is being edited

C/C++ Build Type: Project

C/C++ General Location: JUsers/beth/ews/test1027-scl1-tutorial /shallow .
- a5 + e editor colors
. Last modified: October 31, 2011 3:49:23 PM ] "y

Discovery Options
Environment Text file encoding

- -
Paths and Symbols ® Inherited from container (MacRoman) + Set I n WI n d ow >

Project References

Run/Debug Setti (O Other: MacRoman ¥ f
Preferences

; [T Store the encoding of derived r r ratel
Settings |_] Store the encoding of derived resources separately

Task Repository New text file line delimiter (O n M a C, ECI i pse >

Task Tags

Tool Chain Edit ® Inherited from container
: Preferences)

e .
Variables () Other:

‘ aE + Careful! Dialog is
very similar
3-100
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Converting to a Fortran Project

+ Are there categories labeled Fortran General
and Fortran Build in the project properties?

type filter text

esource
[ - Resource |
Builders ath:
C/C++ Build e:
C/C++ General (T

Project References st modifie .
Remote Development ] Do this
Remote Paths and Symbc ext file e once

Run/Debug Settings
Service Configurations

+ If not, the project is not a Fortran Project
+ Switch to the Fortran Perspective

+ In the Fortran Projects view, right-click on the
project, and click Convert to Fortran Project

+ Don’ t worry; it’ s still a C/C++ project, too [RESTEEUEULT

+ Every Fortran project is also a C/C++ Project
Module 3 3-101
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Project Location

+ How to tell where a project
resides?

Properties for shallow

Resource

+ In the project properties Path: fshallow

dialog, select the C/C++ Build Type:

C/C++ General Location: fUsers/beth/ews/test1027-scll-tutorialysha

Resource category cvs

Discovery Options
Environment
Paths and Symbols ® Inherited from container (MacRoman)
Project References ~

Run/Debug Settings O Other: MacRoman

Service Configurations
Settings

Task Repository

Task Tags

Tool Chain Editor ® Inherited from container
Validation
Variables
WikiText

Last mod

Text file encoding

[ Store the encoding of derived resources separately

—

New text file line delimiter

() Other:
R
( cancetl ) Ok
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Error Parsers

+ Are compiler errors not appearing in the
Problems view? Do this

once
+ Make sure the correct error parser is enabled

+ In the project properties, navigate to
C++ Build»Settings or Fortran Build »Settings

+ Switch to the Error Parsers tab
+ Check the error parser(s) for your compiler(s)

¢ Binary Parsers % S Ervor Parsers

% CDT GNU Make Error Parser 6.0 (Deprecated)

4= Photran Error Parser for GNU Fortran (gfortran)
£=CDT GNU C/C++ Error Parser

£=CDT GNU Linker Error Parser

£=CDT GNU Assembler Error Parser

= Photran Error Parser for Absoft Fortran

= Photran Error Parser for Intel Fortran 8.1

== Photran Error Parser for Lahey/Fujitsu Fortran 7.1

SN NG
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Fortran Source Form Settings

+ Fortran files are either free form or fixed form;
some Fortran files are preprocessed (#define, #ifdef, etc.)

+ Source form determined by filename extension
+ Defaults are similar to most Fortran compilers:

Fixed form: .f fix for fpp ftn f77

Free form: .fO8 .fO3 .fo95 .f90 < unpreprocessed
.FO8 .FO3 .F95 .F90 < preprocessed

+ Many features will not work if filename extensions

are associated with the wrong source form
(outline view, content assist, search, refactorings, etc.)
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Fortran Source Form Settings .

Do this
once

Properties for shallow

+ In the project
properties, select

Builders Source form/filename associations:

Fo rt ra n Gene ra I > »C/C++ Build File Name/Extension Source Form

»C/C++ General
*F Fixed Form - INCLUDE lines ignored

Sou rce Fo rm >$:riran Build

¥ Fortran General
Analysis /Refactoring *.Fo8 Free Form - C Preprocessed

+ Se | eCt source fO m ﬁﬁm ~F77 Fixed Form - INCLUDE lines ignored
fo r ea C h fi I e n a m e Project References *FS0 Free Form - C Preprocessed

Run/Debug Settings * F95 Free Form - C Preprocessed

extension

P Validation

Source Form

*.FO3 Free Form - C Preprocessed

Fixed Form - INCLUDE lines ignored
*.FOR Fixed Form - INCLUDE lines ignored

e Cl |Ck O K «FPP Fixed Form - INCLUDE lines ignored
*FTN Fixed Form - INCLUDE lines ignored
«f Fixed Form - INCLUDE lines ignored

Free Form

Free Form

Fixed Form - INCLUDE lines ignored

Cancel
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Enabling Fortran Advanced Features

+ Some Fortran features are disabled by default @

+ Must be explicitly enabled Do this

+ In the project properties dialog,
select Fortran General » Analysis/Refactoring

+ Click Enable

Ana IySiS/ fype ISter text Analysis/Refactoring
Refactoring > Resource

Builders To enable Open Declaration, Find All Reference

»C/C++ Build view, content assist, and refactoring in Fortran

+ C | OSG a n d re'O pe n »C/C G | following box. A program database (index) wil
v enera a Fortran file is created or saved.

any Fortran editors o

» Fortran Build

e OO0 Properties for shallow

¥ Fortran General

1
+ Th = t th @] Enable Fortran Declaration view
I S U rn S O n e Paths and Symbols ™ Enable Fortran content assist (Ctrl+Space)

“Photran Indexer” Profect neferences  Enable Fortran Hover tps
+ Turn it off if it’ s slow &

Module 3
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Project Properties — Try It!

. Convert shallow to a Fortran project

. Make sure errors from the GNU Fortran
compiler will be recognized

. Make sure *.f90 files are treated as
“"Free Form” which is unpreprocessed

4. Make sure search and refactoring will work in
Fortran
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Advanced Editing

Code Templates
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Code Templates

(C/C++ and Fortran)

+ Auto-complete common code patterns
+ For loops/do loops, if constructs, etc.
+ Also MPI code templates

+ Included with content assist proposals
(when Ctrl-Space is pressed)

+ E.g., after the last line in tstep.f90, type “sub” and
press Ctrl-Space

+ Press Enter to insert the template

b decs.h L] init.c [F] *tstep.f90

end do A
/ end subroutine

29  sub

subroutine...end subroutine - Subroutine (lower case)
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Code Templates (2)

(C/C++ and Fortran)

+ After pressing enter to insert the code
template, completion fields are highlighted

Lh| decs.h .c] init.c F] *tstep.fo0 3

89~ subroutine Fa parameters)
14

31  end subroutine name

+ Press Tab to move between completion fields

+ Changing one instance of a field changes all
occurrences
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Advanced Editing — Try It!

-u 3\\

+ Open tstep.f90 and retype the last loop nest
+ Use the code template to complete the do-loops

+ Use content assist to complete variable names
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Custom Code Templates

(Fortran)

+ Customize code templates in Window »
Preferences » Fortran » Templates

Preferences

Templates

» Ceneral

» Ant Create, edit or remove templates:

PC/C++ Name Context Description

P Dynamic Languages QT allocate (...) Fortran Allocate statement (lower case)

VFortran @1 ALLOCATE (...) Fortran Allocate statement (upper case)
CDT Integration ™ call ... Fortran Call statement (lower case)
Editor ™ CALL ... Fortran Call statement (upper case)

 deallocate (...) Fortran  Deallocate statement (lower case)

> Help (¥ DEALLOCAT... Fortran Deallocate statement (upper case)

P Install/Update @[ do while...e... Fortran Do-while construct (lower case)

> Java ¥ DO WHILE...... Fortran Do-while construct (upper case)

> JavaScript # do...end do Fortran Do-loop construct (lower case)

P Parallel Tools @1 DO...END DO Fortran Do-loop construct (upper case)

» PHP  forall...end... Fortran Forall construct (lower case)

P Plug-in Development IQT FORALL...E... Fortran Forall construct (upper case)

P Remote Systems # function...e... Fortran Function (lower case)

»Remote Tools V FUNCTION..... Fortran Function (upper case)
PRun/Debug M if then Fartran If-then ranctrict (lower Face)

Service Configurations

+ Can import/export templates to XML files

Module 3
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Refactoring and Transformation
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Refactoring

(making changes to source code that don’t affect the behavior of the program)

T — Refactoring is the research
X . . .

Rename... : motivation for Photran @ Illinois

B Variabl ' Illinois is a leader in refactoring research
Extract LoC ol “ L, : .

IMPLICIT NONE... Refactoring” was coined in our group
Introduce (Opdyke & Johnson, 1990)
jable . i .

Encapsulate V2" e We had the first dissertation...

g H u e
Make Prl\?tcelf::LtZO USE gtatement.- (Opdyke, 1992)
Add ONUY 10 st e ...and built the first refactoring tool...
Minimize variable Names C%T:csk (Roberts, Brant, & Johnson, 1997)

MON V2 MMON B1Z :

Make gAyEVariabl to 0 ...and first supported the C preprocessor
Move o (UnchECked)"' 7 (Garrido, 2005)

ng , :
interchd ord Ca5E o « Photran’s agenda: refactorings for HPC,
un‘?f:g;so'e‘e oper® language evolution, refactoring framework
Rep!d
Debuggmg) .

Photran 7.0: 31 refactorings
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Refactoring Caveats

+ Photran can only refactor free form code that
IS not preprocessed
+ Determined by Source Form settings

(recall from earlier that these are configured in
Project Properties: Fortran General»Source Form)

v Free Form, Unpreprocessed: .f08 .f03 .f95 .f90

Free Form, Preprocessed: .FO8 .FO3 .F95 .F90
Fixed Form: f fix .for .fpp .ftn .f77

+ Refactor menu will be empty if
+ Refactoring not enabled in project properties

(recall from earlier that it is enabled in
Project Properties: Fortran General»Analysis/Refactoring)

+ The file in the active editor is fixed form

+ The file in the active editor is preprocessed
Module 3
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Rename Refactoring

(also available in Fortran)

+ Changes the name of a variable, function, etc.,

including every use
(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal

(aware of scoping rules, namespaces, etc.)

Fle Edit Source Navigate Search Projel SN VVI| ol g o) C/C-|-+ Perspective

Rename... Shift+Alt+R

S| & x + Open a source file

d|v v *o (ov Extract Local Variable Shift+Alt+L

Extract Constant... Alt+C + In the editor, click on a
Extract Function... Shift+Alt+M Variable or function name

.5 Project Explorer

In Java (Murphy-Hill et al., ICSE 2008): 4 Select menu item
_Refactoring  Uses Percentage Refactor» Rename

Rename 179,871 74.8%

Extract Local Variable 13,523 5.6%

Mo s ssq +0Or use context menu
Extract Method 10,581 4.4%

Change Method Signature 4,764 2.0% + E n te r n eW n a m e

Inline 4,102 1.7%

Extract Constant 3,363 1.4%

(16 Other Refactorings) 10,924 4.5%
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Rename in File

(C/C++ Only)

4+ Position the caret \c| worker.c 53
over an identifier. 106 time_unload(prv,nxt, tu_my_1id,

)
30 int prv;
) int nxt;
) int tu_my_1id;
310 int jstart;
311 int jend;
312 float dvdt[n][m];
] Eeighboﬂr_senQ(nxt, tu_my

neighbour_receive(prv, tu

4+ Press Ctri-1

(Command-1 on Mac).

+ Enter a new name.
propagated within -

the file as you type. 3151

]
]
]
Changes are ,
]
]
]
]
]

) this 1s a general purpose fun
.: (- ) *

121 neighbour_send(ns_neighbour,n
322 int ns_neighbour;

323 int ns_my_1id;

324 int ns_rec_1id;
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Extract Function Refactoring

(also available in Fortran - “Extract Procedure”)

+ Moves statements into a new function, replacing the
statements with a call to that function

+ Local variables are passed as arguments

Changes to be performed

v 23 init.c - shallow
elbis + Select a sequence of
Original Source Refactored Source
q o 82 statements
; FOZOE’J(T 3;03 : f;m?*ﬁﬁ { 83 for (j =05 j < n; J++) { I )
2031041 - 0.5 84 for (i=0; i <m iss) + Select menu item

} z[j1[1] = 9.,
e} Refactor»
’ Extract Function...

+ Enter new name

5}

s R o0 prinbamerOr ]
'S5 printf("Shallow water weather model - [ "l_} LI AL L{OT 1]
) printf("Number of points in the X direc
1 wets nw kL MMl AL AT mbks T kA VA A .
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Introduce ImpLICIT NONE Refactoring

+ Fortran does not require variable declarations
(by default, names starting with I-N are integer variables; others are reals)

+ This adds an IMPLICIT NONE statement and adds explicit
variable declarations for all implicitly declared variables

Introduce Implicit None + Introduce in a single file by
Changes to be performed ST -2 opening the file and SeleCting

o v @3 Introduce Implicit None

Refactor»Coding Style»
Introduce IMPLICIT NONE...

G tstep.f90

Original Source Refactored Source

subroutine tstep(m,nigé subroutine tstep(m, * Introduce In multlple ﬂles by

use, intrinsic :: use, intrinsic ::

. LBl selecting them in the Fortran
in egerf(kmd—C_INT), :mteger 1 : f ) . .
reserQeind-CnNgs, | et Projects view, right-clicking on
the selection, and choosing
Refactor» Coding
Style» Introduce IMPLICIT

NONE...
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Loop Transformations

(Fortran only)

+ Interchange LOOPS CAUTION: No check for behavior preservation
+ Swaps the loop headers in a two-loop nest

+ Select the loop nest, click menu item Refactor»Do Loop»
Interchange Loops (Unchecked)...

e OO0 Interchange Loops (Unchecked)

Changes to be performed &4 4 v v
o v @ Interchange Loops (Unchecked)

V] 2 tstep.f90 - shallow

tstep.f90

Original Source Refactored Source

61 doi=1, m 61 do j = jstart+l, jend+l

62 do j = jstart+l, jend+l 62 doi1=1, m

63 pnew(1,3j) = pold(i,j) + tdt 63 pnew(1,3j) = pold(1,j
64 unew(i,3j) = uold(i,j) + tdt ! unew(i,j) = uold(i,j
b vnew(i,3j) = vold(i,j) + tdt

vnew(1i,3j) = vold(i,]
end do 66 end do

end do end do
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Loop Transformations

+ Unroll Loop

(Fortran only)

+ Select a loop, click Refactor»Do Loop»Unroll Loop...

do i =1, 10
print *, 10*1

end do

Unroll 4 x

doi=1, 10, 4
print *, 10*1
print *,
print *, 10*
print *

end do

(
y 107%(

10* (1+1)

G tstep.fo0

Original Source

! Don't apply time filter on first
if ( firststep == @ ) then
do j = jstart+l, jend+l

doi=1, m
pold(i,j)
uold(i,3)
vold(i,j)

end do

end do
end if

p(1,j)+alpha*(pne
u(i,jd)+alpha*Cune
v(1i,j)+alpha*(vne

do j = jstart+l, jend+l

doi=1, m

p(i,3) = pnew(i,j)
u(i,j) unew(i,j)
v(i,j) vnew(i,j)

end do
end do
#7-end subroutine

Refactored Source

end do
end if

do j = jstart+l, jend+l
loopUpperBound = m
do 1 = 1, loopUpperBound,4
p(1,3) = pnew(i,j)
u(i,j) unew(i,j)
v(i,Jj) vnew(i,j)
p((i+1),3) = pnew((i+1)
u((i+1),3) = unew((i+1)
v((i+1),3) vhew((i+1)
p((i+2),3) = pnew((i+2)
u((i+2),3) unew((1+2)
v((i+2),3) vhew((142)
p((i+3),3) = pnew((i+3)
u((i+3),3) unew((1+3)
v((1+3),3) vhew((1i+3)
end do
end do
2 end subroutine

oo
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Refactoring & Transformation — Try It!

In tstep.f90...

1. In init.c, extract the printf statements at
the bottom of the file into a new function
called print banner

. In worker.c, change the spellings of
neighbour send and neighbour receive
to American English

. In tstep.f90, make the (Fortran) tstep
subroutine IMPLICIT NONE
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Module 4: Parallel Debugging

+ Objective
+ Learn the basics of debugging parallel programs

+ Contents
+ Launching a debug session
+ The Parallel Debug Perspective
+ Controlling sets of processes
+ Controlling individual processes
+ Parallel Breakpoints
+ Terminating processes

Module 4
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Debugging Setup

Module 4
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Debugging Setup

Debugging requires interactive access to the
application

Since the PBS resource manager we set up
previously is for batch execution, we need to
set Up a new one

We will use a PBS interactive resource
manager

This only needs to be done once

Module 4
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e
. L3

N\

Adding a Resource Manager

+ Switch to the System Monitoring Perspective
+ Right-click in Resource Managers view and select Add
Resource Manager...

(+) Resource Managers £3 iii: system: forge.n(

(& edu.illinois.ncsa.forge.pbs.batca.openmpi (LML_JAXB)

P Start Resgfirce Manager
Il Stop Regource Manager

Remove Resource Manager
- Edit Resource Manager -

5 Active Jo
Set Default Resource Manager

step s o Susled = _Fltotalcon status

1l 4/87... alberto normal 43200 2011... 2011.. 2 RUNNING

Module 4
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Selecting the Resource Manager

+ Choose the PBS interactive resource manager type that
has been pre-configured for forge

+ edu.illinois.ncsa.forge.pbs.interactive.openmpi

Choose Resource Manager Type

Select the type of resource manager to use

Resource Manager Types:

PBS-Generic-Batch
FRS-Generic-Interactive

edu.iWnois.ncsa.forge.pbs.batch.openmpi
edu.sdsc.trestles.pbs.batch

edu.utk.nics.keeneland.pbs.batch

edu.utk.nics.kraken.pbs.batch

Module 4
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. ‘2\\

Configuring the Resource Manager

Choose Remote Tools for the Remote service
provider

Choose the connection you created previously
Click Next> then Finish

Control Connection configuration

Enter connection information

Remote service provider: | Remote Tools
Connection name:

» Advanced Options

( Cancel )
Ne—

Module 4
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_——
-

D

Start the Resource Manager

+ Right-click on the new resource manager and select
Start Resource Manager from the menu

@ Resource Managers &3 = O ||}l system Monitori

@edu.iIIinois.ncsa.forge.pbs.batc .openmpi (LML_JAXB)

(8 edu.illinois.ncsa.forge.phslnters 2ive 0080l UM IAXE)
~ Start Resource Manager

B Stop Resource Manager

Add Resource Manager...
Remove Resource Manager
Edit Resource Manager

—

5 Active Jobs 83

Set Default Resource Manager

Module 4
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o L

Create a Debug Configuration

A debug configuration is
essentially the same as a run  [isk T rrr—— o
i+ 1 shallow

5 . . @ Resource Managers ..
configuration (like we used ©ccuitnosg Bl Debug As

in module 3) = edu.illinor, ncsafor™ ek g Configurations... N )

" S Organize Favorites...
We will re-use the existing
configuration and add debug 7 -
Informatlon - owner queue wall queued: dispatct totalcor status

5... liweil normal 43200 2011... 2011... 72 RUNNING
Use the drop_down next to of75... liweil normal 43200 2011... 2011... 72 RUNNING
the debug button (bug icon)

... dtche... normal 86400 2011... 2011... 1 RUNNING
instead of run button

Select Debug
Configurations... to open
the Debug Configurations

d Ia I Og step owner queue wall queued: dispatck totalcor status

... alberto normal 43200 2011... 2011... 18 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING
... cheat... normal 43200 2011... 2011... 16 RUNNING

INDEOEECNYEON

% |nactive Jobs 23

Module 4
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_——

-

A

=N

Copy the Existing Configuration

+ Select the existing
configuration

+ Click on the copy button
to create a duplicate
configuration

Module 4

Create, manage, and run configurations

@ [Debugger]: Debugger host must be specified

E /C++ Application

[T |resourceManagers

[C |test Release
[€]C/C++ Attach to Application
[€]C/C++ Postmortem Debugger
E C/C++ Remote Application
[F |Fortran Local Application
[31Java Application
5=} Parallel Application

8=} shallow

Name: Ashallow (1)

5% Resources . [Z] Application | (9= Arguments | Fig

Resource Manager: | edu.illinois.ncsa.forge.pbs.batg

Name

Job Name:

Account:

Queue:

Number of nodes:

Total Memory Needed:

Wallclock Time:

MPI Command:

MPI Number of Cores:

[ Basic P8BS {

ptp_job

00:30:00

| mpirun

4
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Configure the Resource Tab

Select the new
resource manager

Choose the debug
queue

Choose the mpirun
command

Select the number of
cores (in this case
use 4)

Module 4

YN

Debug Configurations

Create, manage, and run configurations
@ (Debugger]: Debugger host must be specified

Name: vshallow (1)

Resources [E) Application | 69= Arguments | B Environment | Synchronize % Debugger E‘ Source | =] Common

[e]C/C++ Application Resource o | edu.illinois.ncsa.forge.pbs.interactive.openmpi

resourceManagers
t Release

[€]c/C++ Postmortem Debug®
[€]C/C++ Remote Application
Efoman Local Application
[51Java Application
8=} Parallel Application Name
8% shallow
shallow (1) Account:

Queue: [ gebug

Total Memory Needed:

MPI Command:

> MPI Number of Cores:

"20gb

00:30:00

mpirun

( View Configuration 9

Restore Defaults

Filter matched 12 of 20 items

[ Basic PBS Settings |

Description

Account to which to charge this job.

Maximum amount of memory used by all concurrent processes in the job.
Maximum amount of real time during which the job can be in the running state.
Which mpi command to use.

the '-np' value [usually equals Nodes*ppn]




Configure the Debug Tab

S e I e Ct De b u g g e r — : : Debug Configurations
tab '

Set the debugger S ~>.
g g ype filter text E:j Resources j Application | ()= Arguments T’ﬁEnvironment Synchronfze #;;Debugger Source | =] Common
- c ++ i
path to the sdm in Pebueser B8
c |resourceManagers
C |test Release
@ Stop at main() on startup

your home directory ju one || oonggeropn

Debugger backend:

F |Fortral ion
b = TlJava . gdb-mi
D e u g g e r S e S S I O n E%Purallel Application Path to debugger executable:
53 shallow /u/ac/tramXX/sdn’(

address should not ents
need to be changed

Click on Debug to
launch the program

Filter matched 12 of 20 items

@
\&/

Module 4
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Debugging the Application

Module 4
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The Parallel Debug Perspective (1)

+ Parallel Debug
view shows job
and processes
being debugged

Debug view shows
threads and call
stack for individual
processes

Source view
shows a current
line marker for all
processes

Module 4

0o Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspace

v =1 ﬁ;va@ Q-

£ parallel Debug &2 3 . | 2R
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - Root [4]

£3 job0 ”E > > P>

O~ = 3 . B =1
® 0|8 -

[ ¥ Parallel Debug 888 Parallel Runt... FiglRemote C/C...
{}+ = O | 9 Breakpoi |G Expressi |()= Variables £3 {11 Arrays | )= Variables

=

578 Signals

Name Value
@ argc 1
@ argv 7fffffffd658
@ pi 5.957805E-39
%5 Debug 52 &3 0 * ep [0 - 18]
5=} shallow [Parallel Application] Qu [0 - 18]
Process 0 @V [0 - 18]
1/ Thread [1] (Suspended) @ psi [0 - 18]

= 1 main() main.c:38 4032ca €

= 0| 5= outline &2

PR o %

math.h

+€| main.c P9
2MPI_Datatype * setup_res();

imain (argc, argv)
‘ int argc; O mpi.h
¢ char * argv[]; ™ stdio.h

{ decs.h
8 float pi=4.*(float)atan((double)l.); “+ worker() : void

float  p[n][m]; -+ setup_res() : MPI_Datatype*
222: :E:% E:% ’ main(int, char*(])

float psiln] [r,n] ; setup_res() : MPI_Datatype*
float pold[n][m];
float uold[n][m];
float  vold[n][m];
float h[n][m];

float z[n][m];

float dummyl[m];

float dummy2[n][m];
float tpi=pi+pi;

float di=tpi/(float)m;
float dj=tpi/(float)n;

/* Pressure (or free surface height) */
/* Zonal wind */

/* Meridional wind */

/* Velocity streamfunction */

B console 2
Open_MPI@abe.ncsa.uiuc.edu:default:job0

@ Memory| [2{ Problems

Open Mpi Job

update_global_ds(MPI_Datatype
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The Parallel Debug Perspective (2)

Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspace

[ ¥ Parallel Debug 888 Parallel Runt... FiglRemote C/C...

— ﬂ 99 Breakpoi |67 Expressi |()= Variables &3 &% Signals | {11 Arrays | 0= Variables

+ Breakpoints view
S h OWS b rea prI n tS g}!:;:lPl@abencsa.uruc.edu‘ def:%.;ob'o -'Roo't 4] . _ o

that have been set 2 S roasse
%5 Debug &3 B2 0 3 @p [0 - 18]

( m O re O n th I S I a te r) 8- shallow [Parallel Application] Qu [0 - 18]

Process 0 Qv [0 - 18]
pTead (1) (Suspended) @ psi [0 - 18]

Va riables Vlew = 1 main( main.c:38 4032ca
shows the current
values of variables KR =502 owime 5

2MPI_Datatype * setup_res(); BRY o ¥

for the currently D A

int argc;
char * argv[]; Al stdio.h

{ decs.h
S e I e Cte d p ro Ce S S I n 8 float pi=4.*(float)atan((double)l.); " worker() - void
& ) float p[n][m]; /* Pressure (or free surface height) */ : setup_res() : MP|_Datatype*
th D b 4 float uln][m]; /* Zonal wind */ - - iy
e e u g V I eW 1 float  v[n][m]; /* Meridional wind */ main(int, char*(})
42 float psi[n][m]; /* Velocity streamfunction */ setup_res() : MPI_Datatype*
float  pold[n][m]; update_global_ds(MPI_Datatype

Outline view (from [T
4 float h[n][m];

CDT) Of Source flat dumm;lJ[r;'];

float dummy2[n][m];

d 5 float tpi=pi+pi;
CO e 51 float  di=tpi/(float)m;

float dj=tpi/(float)n;

=2

B console 2 @ Memory| [£( Problems
Open_MPI@abe.ncsa.uiuc.edu:default:job0

Open Mpi Job

Module 4




Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspa

2 C T, Q- G 1 3 A v v (=L N=L £ #R paral
The bUttonS N the eRratinbDabus { m | R R 3 & & | {z}v = O || % Breakpoi |& Expressi |()= varial

Parallel Debug View .
control groups of T

prOCGSSGS 1 | :::gv
' Mk ) & @p

CI iC k O n t h e Ste p Ove r §hallow [Parallel Application] — = = Qu

&® Process 0 (Suspended) Qv

b U tto n o Thread [1) (Suspended) @ psi
€

Observe that all process

icons change to green,
then back to yellow B manc

¢ float pi=4.*(float)atan((double)l.);

H 39 f ; /* Pressure r free surface hei ) */
Notice that the current % oot plilel; /2 Presurs Cor ace height) */
H ! float [n]1[m]; /* Meridional wind */
Ilne ma rker has moved to 42 flgzt ;s?[n;‘[m]; /* Velocii;astv*e;w?unction */

. 13 float pold[n][m];
the next source line @ float  ueldCnlind;
45 float vold[n][m];
16 float h[n][m];
float z[n][m];
float dummyl1[m];
float dummy2[n][m];
float tpi=pi+pi;
float di=tpi/(float)m;
float dj=tpi/(float)n;
int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];
float v_start[m];

Module 4
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Stepping An Individual Process

The buttons in the
Debug view are used
to control an
individual process, in
this case process 0

Click the Step Over
button

You will now see two
current line markers,
the first shows the

position of process O,
the second shows the

positions of processes
1-3

Module 4
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_—

eno Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing /works

Civ ‘ol'o Q@ Qr |[O- 2B 4 E ' N E £ gEra

¥ Parallel Debug &3 1= ] ‘ 2} & 0|8 - {=}v = O |9 Breakpoi |67 Expressi |()=Va
Open_MPI@abe.ncsa.uviuc.edu: default:job0 - Root [4]

£3 job0 0 > > P> Name

@ argc
@ argv
@ pi
%5 Debug 53 Sl 2 T @p
8=} shallow [Parallel Application] @u
&2 Process 0 (Suspendes Y
: gad [1) (Suspended) @ psi
= 1 main() main.c:51 403309

v£| main.c &2
float pi=4.*(float)atan((double)l.);
float p[n][m]; /* Pressure (or free surface height) */
float uln][m]; /* Zonal wind */
float  v[n][m]; /* Meridionagl wind */
float psi[n][m]; /* Velocity streamfunction */
float pold[n][m];
float uold[n][m];
float  vold[n][m];
float  h[n][m];
float z[n][m];
float dummyl[m];
float dummy2[n][m];
float tpi=pi+pi;
float di=tpi/(float)m;
float dj=tpi/(float)n;
int i, j, chunk_size, nxt, prv;

int master_packet[4];
float p_start[m];
float u_start[m];
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Process Sets (1)

+ Traditional debuggers apply operations to a single
process

+ Parallel debugging operations apply to a single process
or to arbitrary collections of processes

+ A process set is a means of simultaneously referring to
one or more processes

Module 4
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Process Sets (2)

+ When a parallel debug session is first started, all
processes are placed in a set, called the Root set

+ Sets are always associated with a single job
+ A job can have any number of process sets
+ A set can contain from 1 to the number of processes in

Module 4
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Operations On Process Sets

+ Debug operations on the
Parallel Debug view
toolbar always apply to the
current set:

+ Resume, suspend, stop,
step into, step over, step
return

+ The current process set is
listed next to job name
along with number of
processes in the set

+ The processes in process
set are visible in right hand
part of the view

Module 4

2% parallel Debug &3 B w3 G
Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root (4]
£3 job0

v i} shallow [Parallel Agblication]
v &2 Process 0
v 1 ThreagA1] (Suspended)

= 7 main() main.c:49 2cc5

Root set = all processes
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Managing Process Sets

+ The remaining icons in the toolbar of the Parallel
Debug view allow you to create, modify, and delete
process sets, and to change the current process set

Create set Remove
from set

7% parallel Debug &3 B . 2R Cha nage
Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4] g

£ job0 @5+ » current set

%% Debug 53 g v | & Delete

v E§hallow [Parallel Application] Set
v &2 Process 0
v 7 Thread [1] (Suspended)

Module 4




Select the processes 5 parallel Debug & L EX:

you want in the set by g?:t;gdPl@abe.ncsa.u|uc.edu: default:job0 - Root [4]

clicking and dragging, -

in this case, the last R

three ‘[ Please enter the new set name.
C||Ck on the Create #Tshallow [Parallel Appli ke

v 5@ Process 0 (Suspend

Set button v /@ Thread [1] (Susp|

Enter a name for the 1 main() main
set, in this case
workers, and click OK

You will see the view
change to display only
the selected processes
% Parallel Debug &3 B TR & O | (¢ (&= 0

Open_MPl@abe.ncsa.uiuc.ediingdefault:job0 - workers [3]
£3 job0 A A 4

(" Cancel ) | oK )

Module 4




Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspd

- v = v QD Qr Q- v |2 | v v = . £ ERPara
With the workers set B = . : = .
b@ Parallel Debug &3 1 B, & ‘ e |0 & O || ®g Breakpoi |54 Expressi |®= varia

aCtive, CIiCk the Step Ones .uiuc.edu: default:job0 - workers [3]
Over button A

You will see only the
first current line
marker move

%5 Debug 53
: shallow [Parallel Application]

Step a couple more

times

You should see two line
markers, one for the

» 5l di=tpi/(float)m;

single master process, 2 float  dj-ti/(Floatdn;

int i, j, chunk_size, nxt, prv;

and One for the 3 l int master_packet[4];
worker processes S Flomt  uoskareind:

float v_start[m];

float psi_start[m];
float pold_start[m];
float uold_start[m];
float vold_start[m];
int proc_cnt;

int tid;

MPI_Datatype * res_type;
MPI_Init(&argc, &argv);

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);//hello
MPI_Comm_rank(MPI_COMM_WORLD, &tid);

Module 4
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Process Registration

+ Process set commands apply to groups of
processes

+ For finer control and more detailed
information, a process can be registered and
isolated in the Debug view

+ Registered processes, including their stack
traces and threads, appear in the Debug view

+ Any number of processes can be registered,
and processes can be registered or
un-registered at any time

Module 4
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Process Registration (2)

By default, process 0 was
registered when the debug
session was launched

Registered processes are
surrounded by a box and
shown in the Debug view

The Debug view only shows
registered processes in the
current set

Since the “workers” set
doesn’t include process O, it
is no longer displayed in the
Debug view

Module 4

Parallel Debug - shallow/main.c - Eclip

§’£Parallel Debug 23 (1 = ‘ U & O g‘\ S

Open_MPl@abe.ncsa.uviuc.edu: default:job0 - Root [4]

£3 iob0 0 A 2 4

%5 Debug &3
8=} shallow [Parallel Application)
&2 Process 0
o/ Thread (1) (Suspended)
= 1 main() main.c:38 4032ca

Parallel Debug - shallow/main.c - Eclips:
- & |3 0-@ Q- |O- e ] - e
% parallel Debug 53 B @2 |(®&0 A0 0| =8

Open_MPI@abe.ncsa.uviuc.edu: default:;job0 - workers [3]

£3 jobo

I A4

®v =0

%5 Debug £3 b ‘

: shallow [Parallel Application]
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Registering A Process

Parallel Debug - shallow/main.c -

+ To register a process, & %50 Q- |O- |4 iz ]S #-

double-click its process |t B W2 |80 [RA[ 0 ¢ 0@ T O)|% sreay

Open_MPl@abe.ncsatreasdu: default;job0 - workers [3]
icon in the Parallel £3 iobo
Debug view or select a
number of processes and ——
click on the registel“ & shallow [Parallel Application]
button @ process 3 (Suspended) Individual

o Thread (1) (Suspended)

= 1 main() main.c:67 403335

processes

Groups (sets)
of processes

TO un-register a proCess, [ T
double-click on the 60 float pold_start[m];

61 float uold_start[m];

process icon or select a ©2 float vold start[n];

int proc_cnt;

number of processes and |IEEENEE

MPI_Datatype * res_type;

click on the unregister VIR —

MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);//hello
bUtton MPI_Comm_rank(MPI_COMM_WORLD, &tid);

fprintf(stdout, "my rank is %d\n", tid);

if ( proc_cnt < 2 )

Module 4
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Current Line Marker

+ The current line marker is used to show the
current location of suspended processes

+ In traditional programs, there is a single
current line marker (the exception to this is
multi-threaded programs)

+ In parallel programs, there is a current line
marker for every process

+ The PTP debugger shows one current line
marker for every group of processes at the
same location

Module 4
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Colors And Markers

l.c| main.c 23
+ The highlight color depends on int piay
the processes suspended at
. . MPI_Init(&argc, &argv);
that ||ne . MPI_Comm_size(MPI_COMM_WORLD, &proc_cnt);
. MPI_Comm_rank(MPI_COMM_WORLD, &tid);
+ Blue: All registered process(es) T
* orange: A” unreQIStered process t fprintf(stderr, "must have at least 2 processes, not %¥d\n", proc_cnt);
(es) MPL_F‘,n;‘A.lizc();
return 1;
+ Green: Registered or unregistered

}
process with no source line (e.g.
suspended in a library routine)

Multiple processes marker

The marker depends on the
type of process stopped at that Registered process marker
location

Ed Un-registered process marker

Hover over marker for more

details about the Processes Multiple markers at this line

suspend at that location -Suspended on unregistered process: 2
-Suspended on registered process: 1

Module 4
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Breakpoints

+ Apply only to processes in the particular set that is
active in the Parallel Debug view when the breakpoint
is created

+ Breakpoints are colored depending on the active
process set and the set the breakpoint applies to:

+ Green indicates the breakpoint set is the same
as the active set.

+ indicates some processes in the breakpoint set are
also in the active set (i.e. the process sets overlap)

+ Yellow indicates the breakpoint set is different from the
active set (i.e. the process sets are disjoint)

+ When the job completes, the breakpoints are
automatically removed

else{
| print
MPI_Final

Module 4
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Creating A Breakpoint

+ Select the process set that
the breakpoint should apply
to, in this case, the workers
set

Double-click on the left edge
of an editor window, at the
line on which you want to set
the breakpoint, or right click
and use the Parallel
Breakpoint» Toggle
Breakpoint context menu

+ The breakpoint is displayed
on the marker bar

Module 4

Mo Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/workspa

S| 02 Q|02 |B [ HFl e i B parall

g@Parallel Debug &3 13 |, D ‘{iﬁ‘} {} ‘@3\ G~ & | &y = 0|9 Breakpoi |G Expressi |09= Variah
Open_MPI@abe.ncsa.uiuc.edu: default:job0 - workers [3]

£3 job0 ppu—

Name
@ argc
@ argv
@ pi
%5 Debug 2 5 OB /D = @p
53 shallow [Parallel Application] @u
&2 Process 3 (Suspended) U
o Thread [1) (Suspended) @ psi
= 1 main() main.c:38 4032ca

;¢) main.c 23
MP L_ LG FARR(MP L CUMM_WURLU, &t1aJ;

fprintf(stdout, "my rank is %d\n", tid);

if ( proc_ent < 2 )

fprintf(stderr, "must have at least 2 processes, not %d\n", proc_cnt);
MPI_Finalize();
return 1;

}

if ( (n % (proc_cnt - 1)) 1= 0 )]
{
if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a multiple of %d\n", n);

MPI_Finalize();
return 1;

}
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Hitting the Breakpoint

SN O Parallel Debug - shallow/main.c - Eclipse - /Users/greg/testing/

Switch back to the Root set
by clicking on the Change
Set button

Click on the Resume button
in the Parallel Debug view

In this example, the three
worker processes have hit the
breakpoint, as indicated by
the yellow process icons and
the current line marker

Process O is still running as its
icon is green

Processes 1-3 are suspended
on the breakpoint

Module 4

2 parallel Debug 3
Open_MPl@abe.nc

g shallow [Parallelfpplication]
&2 Process 348uspended)
o Thrglid [1) (Suspended: Breakpoint hit.)

|8 ]3O Q- O3 A+ il o

B 100 @ | XL
c.edu: default:job0 - Root [4]

By + €

Name
@ argc
@ argv
@ pi
@p
Pu
v
@ psi

=_ 1 main() main.c:80 4033c4

Thread (3] (Suspended)

1@ Thread [2] (Suspended)
Process 0
3@ Thread [1) (Running)

fprintf(stderr, "must have at least 2 processes, not %¥d\n", proc_cnt);
MPI_Finalize();
return 1;

}
if ( (n ¥ (proc_ent - 1)) 1= 0 )
{

if ( tid == 0 )
fprintf(stderr, "(number of processes - 1) must be a multiple of %¥d\n", n);

MPI_Finalize();
return 1;

}

if (tid 1= 9) {
worker();
MPI_Barrier(MPI_COMM_WORLD);
MPI_Finalize();

} else {

{}v = 8|9 Breakpoi |7 Expressi |
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-u ‘2\\

More On Stepping

The Step buttons are only

enabled when all processes
in the active set are = ‘
suspended (yellow icon) &b Parallel Debug 2

Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4]

In this case, process 0 is still [y
running

Switch to the set of
suspended processes (the |
workers Set) # parallel Debug 53

You W||| NOW Ssee the Step Open_MPI-@abe.ncsa.uiuc.edurz default:job0 - workers [3]
buttons become enabled £3 jobo 1y > b

Module 4
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Breakpoint Information

+ Hover over breakpoint icon
+ Will show the sets this breakpoint applies to

+ Select Breakpoints view
+ Will show all breakpoints in all projects

% Breakpoints £3 . S Expressions|®)= Variables

LRI EENER:
4 & main.c [line: 78] {job0:workers}

Module 4
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au Q

Breakpoints View

+ Use the menu in the breakpoints view to group
breakpoints by type

+ Breakpoints sorted by breakpoint set (process
set)

9 Breakpoints £3 . & Expressions|®= Variables =08
R#-x|BES|N| e 7l

™ v & workers  Add Event Breakpoint (C/C++)...
4 & main.c [line: 78] {jobO:workers}

%% 1 Breakpoints

oo Select Default Working Set... &% 2 Breakpoint Types

oo 3 Breakpoint Working Sets
| 4 Files
# Show Qualified Names
=% 6 Projects
= 7 Resource Working Sets
| 1= 8 Advanced...

Working Sets...

o* Focus on Active Task

Module 4
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Global Breakpoints

+ Apply to all processes and all jobs

+ Used for gaining control at debugger startup
+ To create a global breakpoint

+ First make sure that no jobs are selected (click in white
part of jobs view if necessary)

+ Double-click on the left edge of an editor window

+ Note that if a job is selected, the breakpoint will apply to
the current set

if (my_rank !'= 0) {
/* create message */
sprintf(message, "Greetin

Module 4




Terminating A Debug Session

+ Click on the Terminate
icon in the Parallel
Debug view to
terminate all processes
in the active set

Make sure the Root set
is active if you want to
terminate all processes

You can also use the
terminate icon in the
Debug view to
terminate the currently
selected process

Module 4

eSO

O- | | B

#2 parallel Debug 53 =g | ‘ & O

Open_MPl@abe.ncsa.uiuc.edu: default:;job0 - Root [4]

£3 job0 B+ + @

Parallel Debug - shallow/main.c - Eclip{

010 ‘v‘:?v O'?'(/u' 0' am | B A v " e
%’,{{?Parallel Debug 23 (B ) ‘ 2w & 0|8 S| o ‘(S}' = b

Open_MPl@abe.ncsa.uiuc.edu: default:job0 - Root [4]

£3 job0 0 L 2 4

%5 Debug 53
8=} shallow [Parallel Application)
&2 Process 0 (Suspended)
o Thread (1) (Suspended)

= 1 main() main.c:50 40326

Parallel Debug - sha

{y
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Module 5: Performance Tuning
and Analysis Tools

+ Objective

+ Become familiar with tools integrated with PTP, to help
enhance performance of parallel applications

+ Contents

+ Performance Tuning and external tools:

+PTP External Tools Framework (ETFw), TAU
Hands-on exercise using TAU with PTP

+ MPI Analysis: GEM (Graphical Explorer of MPI Programs)
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PTP/External Tools Framework

formerly “Performance Tools Framework”
Goa I [ ] —<tool name="Valgrind">

—<execute>
<utility command=" " group="inbin"/>
—<utility command="valgrind" group="valgrind">

* Red uce t h e W ecl i pse pl um bi n g n — <optionpane title="Val seperatewith="">

<togoption label=" " optname="--leak-check=full" toolti]
<togoption label="Show Reachable" optname="--show-reachable=y

necessary to integrate tools

</utility>
</execute>

+ Provide integration for
instrumentation, measurement, and [EEeETrET————

Build C, C++ or Fortran applications with performance analysis tools. Launch parallel

analysis for a variety of performance [

Name: ‘New_configuratlon

t filter text =
to O I S ‘w‘ P§ Environment | § Parallel

v Parallel Performar || | Tool Selection |valgrind ‘

New_configuraf

v Performance Anal || |select Analysis Tool: |Valgrind

! N [-]
+ Dynamic Tool Definitions: R
WO rkfl OWS & U I memtest [ Build the instrumented executable but do not launch it

Tools and tool workflows are specified in an XML file —

TOOIS a re Selected a nd Conﬂg U red | n the |a U nCh Create, manage, and run configurations
CO nfl g u ratl 0 n WI n d OW Build C, C++ or Fortran applications with performance analysis tools. Launch parallel

programs from within Eclipse via the PTP.

Output is generated, managed and analyzed as X E
specified in the workflow [ope fitertext | | g e ironment  paralle

One_cllck \launchl funCtlona“ty ~ Parallel Performar M‘Valgnndl

New_configural

Support for development tools such as TAU, PPW and  Performance ana | [rieskchec Rl -ehowreachatleyss
Others b @ Leak Check

Adding new tools is much easier than developing a full @ Show Reachable
Eclipse plug-in

Name: |New_configuration

memtest

I Apply ‘ ‘ Revert

Module 5
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TAU: Tuning and Analysis Utilities

TAU is a performance evaluation tool

It supports parallel profiling and tracing

Profiling shows you how much (total) time was spent in each
routine

Tracing shows you when the events take place in each process
along a timeline

TAU uses a package called PDT for automatic instrumentation of the
source code

Profiling and tracing can measure time as well as hardware
performance counters from your CPU (or GPU!)

TAU can automatically instrument your source code (routines,
loops, I/O, memory, phases, etc.)

TAU runs on all HPC platforms and it is free (BSD style license)

TAU has instrumentation, measurement and analysis tools
+ paraprof is TAU’s 3D profile browser

Module 5
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CTAUP

parabel-tools plat
TAU Performance System Architecture

evgnt —| Instrumentation gvent )
selection information  _

symbol |

| profiles table |
' profiles traces '

Profile Data Management (PerfDMF) Trace Data Management

profile etadata profile trace trace
translators (XML) database translators storage

Prof ile Analys1s (ParaProf)

Trace Visualizers  Trace Analyzers

Vampir Expert

JumpShot ProfileGen

Prof ile Dala Mmmg (PerfE \plorer)

/ Vampir
" e B e Paraver P

Server
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PTP TAU plug-ins

http://www.cs.uoregon.edu/research/tau

+ TAU (Tuning and Analysis Utilities)
+ First implementation of External Tools Framework (ETFw)

+ Eclipse plug-ins wrap TAU functions, make them available
from Eclipse

+ Full GUI support for the TAU command line interface

+ Performance analysis integrated with development
environment

MPI_Barrier (MPI_COMM_WORLD) ; emove Block Comment shift+Ctri+\

; i<3; ++) { Content Assist Ctrl+Space
9) Ad e

, 1, 4711, MPI_COMM_WORLD) ; CHNENED ohift 7”‘*”

proc-1, 4711, WPI_COMM WORLD, &status); Fomat Curl+shift+F

PI_Recy(sfield, SIZE, MPIINT, me-1, 4711, MPI_COMM Wi

Refactor
PI_Send(sfield, SIZE, MPI_INT, (me+1)%proc, 4711, WP

2 the PAPI counter ith TAU Lse {
Create, manage, and run configurations PAPI_L1_DCM s

ORLD,
_com,
Create, manage, and run TI gurat Create a configuration to launch a program [ PAPLLLICM Qpen Declaration
unch a progran

X8 % jame: [ing (1)
iter te> |
++ Local Appl
arallel Application arallel Application
§ matmult £ matmult
) PAPLCATV

allpath profilng B ring (1) itop) User Defined Event

i PAPLTLE M -
0 Phase Based Profiing B ring (2) @ Phase Based Profilng fined Event

PAPI_LL LDM
£ testmpl -

select Al | | counter Descri

ounters () Native Counters

fau-mpi-pdk

Select Makefile: [Makefile tau-p

| profile
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TAU Integration with PTP

+ TAU: Tuning and S—
A n a |ys | S U tl I Itl eS ’ Selestive insnml‘l'entation-
* TAU stub makefile selection
+ Performance data

collection and analysis L e

.
Source . ) .
* execution options

fo r H PC COd es moatfication * PAPI environment variables

* TAU compiler options

‘ * TAU environment variables

+ Numerous features

+ Command line interface T\ Sy —e el —
+ The TAU Workflow: [ e T memee e

+ Instrumentation TAU profile data —p:nr;szmliﬂ:::lj

4+ Execution

+ Analysis

slog? file — jumpshot visualization
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TAU PTP Installation

+ This tutorial assumes that the TAU extensions for PTP
are installed - they are not included in the
“Eclipse IDE for Parallel Application Developers”

+ The installation section (Module 1) shows how to install
TAU and other features from the PTP update site -
be sure TAU was selected

Install

Available Software TO Conﬁrm:

vai war

Check the items that you wish to install. +He|p>InSta” NeW SOftWare
+Select the link "What is already
. /4

Work with: | http://download.eclipse.org/tools/ptp/updates/indigo/ 3 InSta“ed at the bOttom Of the

Find more software by working with the “Available Software Sif] d I a Iog

+You should see the TAU
Extension




paratieltools platform

TAU/ETFw Hands-On(0)

Assumptions
+ Obtain and install TAU*

+ Download at tau.uoregon.edu
+ The website includes setup and user guides

+ Set up the $PATH on the remote machine*

+ For TAU you should be able to run ‘which pprof’ on a remote login
and see a result from your TAU bin directory

+ On forge.ncsa.illinois.edu this is accomplished by placing
‘module load tau’ in the .modules file in the home directory

+ Include ‘eclipse.inc’ in the makefile*

+ Create an empty eclipse.inc file in the same directory as the
makefile

+ Place ‘include eclipse.inc’ in the makefile after regular compiler
definitions

+ ETFw will modify eclipse.inc to set CC/CXX/FC variables

Module 5 * SC tutorial: this has been done for you
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TAU/ETFw Hands-On(1) =
Begin Profile Configuration

+ The ETFw uses the same run configurations and
resource managers as debugging/launching

+ Click on the ‘Run’ menu or the right side of the
Proﬂle button

+ From the dropdown menu select ‘Profile
configurations...” £ 0r Qor ur | Ur | @& 77

i 1 shallow-pbs-batch

%, copy  Profile As
SIRETE  Profile Configurations...
Organize Favorites...
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TAU/ETFw Hands-On(2)
Select Configuration

+ Select the shallow configuration Performance Analysis and TAU

prepared earlier tabs are present in the Profile
Configurations dialag

+ The Resource and Application
configuration tabs require little or
no modification

+ We are using the same resource
manager
(edu.illinois.ncsa.forge.pbs.batch.openmpi) -
and PBS settings - B Designation of the queue to which to submit the ob.

Number and/or type of nodes to be reserved for exclusive use by the job.

Since we are using a makefile project ,
the application will be rebuilt in and
run from the previously selected

location

The name assigned to the job by the qsub or qalter command.
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TAU/ETFw Hands-On (3) =
Select Tool/Workflow

+ Select the Performance Analysis tab and
choose the TAU tool set in the 'Select Tool’
dropdown box

+ Other tools may be available, either installed as
plug-ins or loaded from workflow definition XML files

Create, manage, and run configurations P Ta bS may be

@ : :
Build C, C++ or Fortran applications with performance analysis tools. Launch parallel programs from within Eclipse s h|dden |f the
via the PTP. =

A window is too
= S Name: |shallow

@/ || [ B Application (6= Arguments [ Environment (Performance Analysis . 7 TAU| Sma I I
[ ¢/c++ Application Tool Selection | PPW Compiler Wrapper - UPC | PPW Program Run - UPC
# Launch Group Select Tool: TAU
v 83 Parallel Application
2 Add Workflow XML File | | Remove Workflow XML File
&% shallow

Build the instrumented executable but do not launch it

Select existing performance data to analyze with the selected tool
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TAU/ETFw Hands-On (4)

Select TAU Configuration

+ Select the TAU tab

4+ Choose the TAU stub
makefile:

+ All TAU configurations in
remote installation are

available

+ Check MPI, PAPI and PDT
checkboxes to filter listed
NEIGIlES

+ Make your selection in the
Select Makefile: dropdown
0]0)7¢

+ Select Makefile.tau-openmpi-papi-mpi-pdt

Module 5
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TAU/ETFw Hands-On (5)
Choose PAPI Hardware Counters

+ When a PAPI-enabled TAU
configuration is selected the PAPI 2=
Counter tool becomes available

+ Select the '‘Select PAPI Counters’
button to open the tool

+ Open the PRESET subtree

+ Select PAPI_L1_DCM (Data cache
misses)

+ Scroll down to select PAPI_FP_INS
(Floating point instructions)

+ Invalid selections are automatically
excluded

+ Select OK

Module 5
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TAU/ETFw Hands-On (6)
ompiler and Runtime Options

+ Other tab settings are described here
b ut n O Ch a n g eS a re req u | I"ed . E:liitpdsg,vci;:hir:?;tranappli(ationswith performance analysis tools. Launch parallel programs from within

X = Name: |shallow

N [ = Arguments [ B8 Environment [Performance Analysis [ 7 TAU ), Parametric Study|
* I A| | ‘ O m p I e r ptl O r] S 1 ¢/cs+ Applical | A Options | TAU Runtime | Tau Compiler | Selective Instrumentation | Dat:

# Launch Group
vi3 Parallel Applic -tau_options="-optNoRevert -optCompinst

+ Set arguments to TAU

DetectMemoryLeaks | create, manage, and run configurations

- .
C O m I | e r S C r I t S PdtGnuFortranParser| Build C, C++or Fortran applications with performance analysis tools. Launch parallel programs from within
PdtCleanscapeParser Eclipse via the PTP.

PreProcess 5 X B | Name: [shallow

T H KeepFiles = Arguments | B8 Environment [Performance Analysis [ 7 TAU ), Parametric Study|
ontrol instrumentation e el ET e et i

. ¥ Launch Group
P ir
el Verbose Output

and compilation behavior

PdtF95Reset Profile Output Directory

Create, manage, and run configurations

PdtCOpts Profile Format

+ TAU Runtime options

PdtCxxOpts Set Callpath Depth

PdtCxxReset Overhead Compensation

+ Set environment variables

e Communication Matrix

& Enable Throttling
u S e y Filter matched 4 of & Throttle Percall
) & Throttle Numcalls

Enable Tracing

+ Control data collection "

& synchronize Clocks

behavior
Track memory headroom availability at

* AI I O pti O n S i n CI u d ed function entry/exit with a context event

context sensitive help Hover help
Module 5 5-13
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TAU/ETFw Hands-On (7)

_——
w53\
—_——

+ If local PerfDMF
databases are available

you may select one to
hold profile output

+ A text summary may be

printed to the console

+ Profiles may be
uploaded to the TAU
Portal for viewing online
+ tau.nic.uoregon.edu

+ Profiles may be copied
to your workspace

Module 5

E console &

TAU Profile Output
MULTI GET TIME OF DAYReading Profile files in profile.*

%Time Exclusive

Analysis Options | TAU Runtime | Tau Compiler | Selective Instrumentation | Data Collection
Select Database: | Default v

& Keep profiles

[& Print Profile Summary

& upload profile data to TAU Portal

&= Properties | ;.. Problems | ¥ Tasks

FUNCTION SUMMARY (total):

Inclusive
total msec

#Subrs Inclusive
usec/call

16,797 1866428 .TAU application
1844640 main

11, 1282002 MPI Init()

4, 545009 worker

1, 20 neighbour receive

1, 18 neighbour send

1, 175 time load

1, 14 MPI Recv()

1, 136 calc load

-~ :alc unload
ipdate global ds
:ime unload
1PI_Isend()
icopy one to two
jcopy two to one

TAU P : istep

ortal Password: 1

ralcuvzh

Zimetend

1PI Finalize()

setup res

INT Tuna c+roat ()

TAU Portal URL: https://tau.nic.uoregon.edu

TAU Portal Username: |wspear
Submit Login Select a workspace

Select Workspace: Testing v

Cancel Reset All |
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TAU/ETFW Hands-On (8)

+ Once your TAU launch is
configured select ‘Profile’ |
Notice that the project rebuilds W|th TAU compiler commands
The project will execute normally but TAU profiles will be generated

TAU profiles will be processed as specified in the launch
configuration.

= ",:._"

If you have a local PerfDMF database the run will show up in the
Performance Data Management view

+ Double click the new entry to view in ParaProf
+ Right click on a function bar and select Show Source Code for

d. Dex
Me
node
node
node
node
node
node
node
node
node
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TAU/ETFW Hands-On (9)

+ Use ParaProf for profile visualization to identify
performance hotspots
+ Inefficient sequential computation
+ Communication overhead
+ I0/Memory bottlenecks
+ Load imbalance
+ Suboptimal cache performance

+ Compare multiple trials in PerfExplorer to identify
performance regressions and scaling issues

+ To use ParaProf, install TAU from tau.uoregon.edu
or use Java webstart from tau.uoregon.edu/paraprof

_—
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GEM
Graphical Explorer of MPI

Programs
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GEM
Graphical Explorer of MPI Programs

+ Dynamic verification for MPI C/C++ that detects:

Deadlocks

MPI object leaks (communicators, requests, etc)
Functionally irrelevant barriers

Local assertion violations

MPI Send/Recv Type Mismatches

+ Offers rigorous coverage guarantees

+ Complete nondeterministic coverage for MPI (MPI_ANY_SOURCE)
+ Determines relevant interleavings, replaying as necessary

+ Examines communication / synchronization
behaviors

Module 5
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GEM - Overview

Executable Front-end for In-situ Partial Order (ISP
program A developed at University of Utah

T Scheduler

- - Proc,
InteTposiion | Contributes “push-button” C/C++ MPI
verification and analysis to the

development cycle
MPI Runtime

Automatically instruments and runs user
i | code, displaying post verification results

Edit_Source Refactor Navigate Search Run Project Window Help
o | @ 6 b G c B0 @A [ B O |- % Gv 9 o [Eece+ &'java

ject Explorer & = 0|([a MPL_TwoDeadlocks.c Makefile | (& mlife-io-stdoutc | [d grsetup. 2 outline 23 I Tasks

void SetUpCtrl(CtriType *ctrl, int nparts, int dbglvl, HPI Comn comm)

= 36 {

MPI_ProcNull_NoDeadlock [/ g7 1 pametisiibh

. — - - - - -
e MPI_Comm_dup (comm, &(ctrl->gcomm)); a *
e ariety of views & tools to facilitate
-5 MPI_ResourceLeakTest MPI_Comm_size(ctrl->gcomm, &ctrl->npes); SetUpCtrl_(CtriType*, int, int, MPI_{
IPI_TwoDeadlocks 1 ChangeNumbering_(idxtype*, idxty
|_TwoDeadlocks —— angel 'g__(idxtyp 3

» Binaries Ctrlanparts : Set the is de-c on the # of ChangeNumberingMesh_(idxtype* H H
b ¢ Debug 4 ctri->gcomn; ChangeNumberingMesh2(idxtype*. e u g g I I I g a I I ru I I I I I le

» i Includes < GraphRandomPermute_(GraphType

v @src 2. Problems | = Console | ¢: GEM Analyzer 3 GEM Browser ;. GEM Console’ o ComputeMovestatistics__(CtriType? -
S understandin
Runtime Informatiop—— ———
oo [rremetome : R P

MPI_TwoDeadlocks.gem
2 MPL_TwoDeadlocks.gem.I(| || Transition: 14133350— Interleaving: 1/1 Step Order for MPI Calls—
~ 5 ParMetis-3.1 {I;‘j j No Ranks Locked | v { > JJ
T Eoem codewngows————— A
[1) ParMetis-3.gem.log ke oo 5 Make Target
Graphs File:io.c  Line: 172 File: io.c  Line: 186
[ 02proc-ptest.gem.log 2 Originating Call  Matching Calls b LS CPP_Test
[ 05proc-ptest.gem.log y g 5 CPP_Test2
B & life
2 10proc-ptest.gem.log :“i*j“” "r';;i '“’jj:‘r o | [ S MPI_AnySrcCanDeadlock
B i e yites
mtest.gem & MPI_HangBug
ptest.gem it (pe < npes.1) { PI_invalidRankscatter
rotor.graph MPI_MatrixMultiply-1
rotor.graph.xyz dl(void *lyour vwgt. your DX DATATYE T > . IDX_DATATYPE, npes-1. 1 MPL MatrixMuitily-2
b i includes MPI_MatrixMultiply-3
» ¢ Manual . . ) . MPI_MatrixMultiply-4
b G METISLb & MPI_Numericalintegration
b [§ parmetis.h & MPI_POE _lllustration
PIProchull NoDeadLock

(Image courtesy of Steve Parker, U of Utah)
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GEM - Views & Tools

Analyzer View
Highlights bugs, and facilitates

post-verification review / debugging

[2 Problems | E Console | /: GEM Analyzer £3 |/ GEM Browser /. GEM Console @ ® Y =0

Runtime Information.

No error nd ck Browse |p—jJ i HBViewerl 1= Browse MPI Calls
ransition: 14/133350——— rnteneaving: 11— Step Order for MPI Calls—

T
{l_rljjj LokErs e [ i_IJJjJ (@® Internal Issue () Program

Code Window

Rank: 6 Rank: 0
File: io.c  Line: 172 File: io.c  Line: 186

(3 Originating Call 2Je Matching Calls
} ;, vwat[i] = your_vwatfi];
}

MAKECSR(i, your_nvtxs, your_xadj); J }
maxnedges = (maxnedges < your_xadj[your_nvtxs]) ? fclose(fpin);

GKfree(&your_xadj, &your_vwgt, LTERM);
}

else {

your_xadj[your_nvtxs] : maxnedges;

if (pe < npes-1) {

MPI_Send((void *)your_vwagt, your_nvtxs*ncon, IDX_DATATYPE, pe MPI_Recv((void *)vwgt, nvtxs*ncon, IDX_DATATYPE, npes-1, 1, com

} }

else {

graph->nedges = xadj[nvtxs];

adjncy = graph->adjncy = idxmalloc(xadj[nvtxs], "ParallelReadGrz j

for (i=0; i<your_nvtxs+1; i++)

xadj[i] = your_xadj[i];

M |

Browser View
Groups and localizes MPI
problems. Maps errors to source
code in Eclipse editor

<] comm-create-no-free.c &2 . [¢ red_blue_assert.c [¢ MPI_MatrixMultiply-4.c [¢ MPI_TwoDeadlocks.c

printf("(%d) is alive on %s\n", rank, processor name);
fflush(stdout);

a FIB

MPI_Barrier(comm) ;|

create the MPI communicator
MPI_Comm_group(comm, &group);
1 MPI_Comm_create(comm, group, &newcomm);

create the MPI
4 MPI Datatype rowtype;
MPI_Type_contiguous(SIZE, MPI_FLOAT, &rowtype);
MPI_Type_commit(&rowtype);

a FIB
MPI_Barrier(comm);

hese out to illustrate resour

printf("(%d) Finished normally\n", rank); 4
]

@@ =0

il
& Console |[2: Problems | ©] Error Log | /. GEM Console | |; GEM Analyzer | GEM Error Browser &

4. 0 errors and 4 wamnings were found |5—j J

8 Deadlocks | @ Assertion Violations |{i. Leaks | (. Irelevant Barriers

< Interleaving: 1

v B1

v B2
1B /MPI_ResourceLeakTest/src/comm-create-no-free.c Line: 49
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GEM - Views & Tools (cont.)

Happens-Before Viewer
Shows required orderings and communication matches
(currently an external tool)
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GEM PTP Installation

+ This tutorial assumes that the GEM extensions for PTP
are installed - they are not included in the
“Eclipse IDE for Parallel Application Developers”

+ The installation section (Module 1) shows how to install
GEM and other features from the PTP update site -
be sure GEM was selected

Install To confirm:
+Help>Install New Software...
+Select the link "What is already
installed” at the bottom of the
dialog

S +You should see the GEM
— Extension

™ L+ PTP Graphical Explorer of MPI Programs (GEM)

Available Software

Check the items that you wish to install.

Work with:  PTP - http://download.eclipse.org/tools/ptp/updates/indigo/ z]

Find more software by working with the "Available Software Sif
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GEM Hands-on (0) =
Assumptions

+ Obtain and install ISP on the target machine *
+ Download ISP at

L™ Project Explorer £3

25 >shallow [dev.eclipse.org

+ Web page has installation instructions -y

[h) decs.h 1.2

+ Configure GEM/ISP paths for
local/remote machine *
+ On forge.ncsa.illinois.edu, the necessary

bin directories have been placed in the
default path for your training account

+ General GEM configuration necessary for [
the shallow project * Instrumented e 1

shallow.gem b time.o
should be built b tstep.o

|o1) worker.o

L d
R In
fin
Nk

5]

|

)

|

* SC tutorial: this has been done for you
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GEM Hands-on (1)

+ No Launch configuration, run GEM directly
+ Locate the trident ¥ Icon on the toolbar
+ From pull-down menu, set number of processes to 2

e
O~ v

Formally Verify MPI Program

“* Set Number of Processes
.~ Formally Verify MPI Program

Set Number of Processes

Set Number of Processes
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GEM Hands-on (2) =

+ Make sure the project is built remotely (on Forge)
+ Locate file shallow.gem in the Project Explorer view

L Project Explorer &3

v = >shallow [dev.eclipse.org]
b [# >main.c 1.
b [gcalcc 1.2
b [a calc.o - [x86_64/le]

+ Right click on shallow.gem and select:

b [p decs.h 1.

et oM + GEM -> Formally Verify Profiled MPI Executable

b [¢ dump.c 1.

b [ dump.o - [x86_64/le]
b @ Includes

b [dinitc 1.2 Debug As
b (@ init.o - [x86_64/le] -

b [@ main.o - [x86_64/le] Profile As

> [timec 1.2 Team

b [ time.o - [x86_64/le] Compare With
b [qtstep.c 1.2 Replace With
> [tstepfoo 13 | & Formally Verify MPI Pronram
b [& tstep.o - [x86_64/le] ‘

b [& worker.c 1.2

b & worker.o - [x86_64/le] Exclude from build...

—— e Then be patient, analysis
Make Targes can take several

seconds...

Properties Alt+Enter

5-25
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GEM Hands-on (3)

+ After the analysis, notice that three new Eclipse views
have opened:

+ GEM Analyzer, GEM Browser, GEM Console

(2. Problems | & Console ' GEM Analyzer 3 ' GEM Browser . GEM Console

+ In the GEM Analyzer View (in focus by default),
notice there were no MPI errors, e.g. deadlock,
assertion violation, but warnings were issued

Runtime Informatio

+ Examine these warnings in the GEM Browser View

Module 5 5-26
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GEM Hands-on (4)

+ Click on the tab for the GEM Browser View

gL Problems | ¥ Tasks | & Console{l /- GEM Browser 23 |/ GEM Analyzer | {¥. GEM Console

+ GEM has found two types of errors:
+ FunCtiOna”y Irrelevant Barriers (unnecessary synchronization)

+ Resource Leaks (allocated MPI data types and request objects not freed)

0 errors and 4 warnings were found

o] Deadlocks_'u Assertion Violations | (/. Leaks | (. Irrelevant Barriers ~_ @ Type Mismatcheé_

+ GEM maps these warnings/errors to the offending line

of source code within the Eclipse editor
Module 5 5-27
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GEM Hands-on (5)

+ Click on Irrelevant Barriers tab
+ Expand the Interleaving 1 tree
+ Select each MPI_Barrier call separately

g, time.c Lc) main.c &3

if (tid =19 )
fprintf(stderr, "(number of processes -

| + Notice you are taken to the

urn 1;

5}

b s corresponding line in the

: | Eclipse Editor

+ This pair (match set) of
MPI_Barrier calls can be
safely removed without
changing program behavior

If you delete only one and run
GEM again, you will notice that

a deadlock is introduced. The
Analyzer View can be used to
examine this. 5-28
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GEM Hands-on (6)

+ Double Click on the Gem Analyzer View tab
+ This makes the view fill the workbench window

+ Examine communication and MPI runtime behavior
using the GEM Analyzer View

C/C++ - Eclipse Platform
File Edit Source Refactor Navigate Search Project Run Window Help ‘ e n a yZe r
jv &9 G~ & B -0 Q- | & 5 V_ h I I
% Problems | & Console | |; GEM Brow: | GEM Analyzer &3 GEM Console I W S u
Runtime Informatiol A A A
[ found. ¢ g jD {* HBViewer | 1 Browse MPI Calls S I I I I I a r 0 I s

Transition: 0/2077 Interleaving: 1/1———
[ e —— T

Code Windows.

[Step Order for MPI Calls—

o
O itemaitssue @ Progam | ° f I g u r e

Originating Call %o Matching Calls

- - -

* - Division of Information Technology  (DIT) . * - Division of Information Technology  (DIT) .
* - Division of Atmospheric Research (DAR) * - Division of Atmospheric Research (DAR)

.

* Finite difference model of shallow water equations based on :- * Finite difference model of shallow water equations based on :- o

* equations” by R. Sadoumey. JAS, 32, 1975. * equations” by R. Sadoumey, JAS, 32, 1975. .

* Code from:- . * Code from:- . o

* "An introduction to three-dimensional climate modelling" * "An introduction to three-dimensional climate modelling” e X a m I n e P 2 P
* by Washington and Parkinson . * by Washington and Parkinson .

*Programmers = David Abramson  (DIT) rcoda@koel.co.mitoz  * *Programmers = David Abramson  (DIT) rcoda@koel.co.mitoz  *

. Paul Whiting (DIT) rcopw@koel.comitoz  * . = Paul Whiting (DIT) rcopw@koel.comitoz  * m a tc h e S

. MartinDix  (DAR) mrd@koelco.mitoz  * . MartinDix  (DAR) mrd@koelcomitoz  *

*Language = BSD c using Argonne NL macros *Language = BSD c using Argonne NL macros

~o/s = Unix SystemV/ *o/s = Unix System V'
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GEM Hands-on (7)

+ Under Step Order for MPI Calls, select Internal
Issue Order. This is the order in which GEM issues
the intercepted MPI calls to the MPI runtime

Step Order for MPI Calls——

+ From the Transition Group, step through the single
interleaving discovered by GEM using the navigation
buttons.

First Transition

. . Focus on a specific rank
Previous Transition

Last Transition
Next Transition
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GEM Hands-on (8)

+ P2P matches shown in Code Windows

-Code Windows

Rank: 0 Rank: 1
File: main.c Line: 150 File: worker.c  Line: 139

o[ Originating Call ol Matching Calls
for(j=0;j<n;j++) { =
acopy_two_to_one(p, p_start, j); for(i=0;i<n;i++){
MPI_Send(&p_start, m, MPI_FLOAT, i, P_ROW, MPI_Recv(&p_start, m, MPI_FLOAT, 0, P_ROW,
MPI_COMM_WORLD); MPI_COMM_WORLD, &status);
acopy_one_to_two(p_start, p, i)
acopy_two_to_one(u, u_start, j);
MPI_Send(&u_start, m, MPI_FLOAT, i, U_ROW, MPI_Recv(&u_start, m, MPI_FLOAT, 0, U_ROW,
MPI_COMM_WORLDY); MPI_COMM_WORLD, &status);
acopy_one_to_two(u_start, u, i);

acopy_two_to_one(v, v_start, j);

acopy_one_to_two(v_start, v, i);
acopy_two_to_one(psi, psi_start, j);
MPI_Send(&psi_start, m, MPI_FLOAT, i, PSI_ROW, MPI_Recv(&psi_start, m, MPI_FLOAT, 0, PSI_ROW,
MP|_COMM_WORLDY); MPI_COMM_WORLD, &status);
acopy_one_to_two(psi_start, psi, i);
acopy_two_to_one(pold, pold_start, j);
MPI_Send(&pold_start, m, MPI_FLOAT, i, POLD_ROW, MPI_Recv(&pold_start, m, MPI_FLOAT, 0, POLD_ROW,
MP|_COMM_WORLD); MPI_COMM_WORLD, &status);
acopy_one_to_two(pold_start, pold, i);




General
Ant
C/C++
Help
Install/Update
Java
JavaScript
Maven
Mylyn
Parallel Tools
> Debug
b External Tools
BT
ISP Settings
b Parallel Languag
b Resource Manag
Viewer

T ]

Preferences

GEM

GEM Preferences

Number of Processes: |2

[J Clear GEM Console on Each Run
[ Request Command Line Arguments
Active View:

® Analyzer O Browser (O Console

Restore Defaults pply

paratieltools platform

GEM Hands-on (9)

[yoefitertexs &
General
Ant
C/C++
Help
Install/Update
Java
JavaScript
Maven
Mylyn
Parallel Tools
b Debug
b Extemal Tools
v GEM

b Parallel Language Develop

b Resource Managers
Viewer

Plug-in Development

Remote Systems

Remote Tools

Run/Debug

Server

Service Configurations

Team

Usage Data Collector

Validation

Web

XML

+ Other Preferences for further GEM Configuration

Preferences

ISP Settings

Command Line Options
[4] Enable FIB
[ Log Total MPI Calls
[J Enable OpenMP

se Blocking sends
[J Report Progress
[4] Use Unix Sockets
[ Verbose Mode

Miscellaneous Options

Port: 9999

Report Progress Every [n] MPI Calls: (4

Host Where ISP Resides

ISP Paths

isp executable: W Browse...
ispcc script: W Browse...
ispCC script: fusr/local/isp/bin Browse...
HB Viewer script: W Browse...

Remote ISP Paths

remote isp executable: |jusr/local/bin Browse...
remote ispce script:  [/usr/local/bin Browse...
remote ispCC script Jusr/local/bin Browse...

Restore Defaults Apply
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GEM Hands-on (10)

+ GEM Help walks through the Managed-Build, PI-C
example created by the new project wizard
+ Help > Help Contents

Help - Eclipse Platform k to start dragging

=
Search: [ Scope: All topics
g

Contents Va0 =

5 v =1 8
Workbench User Guide I MPI Prog A -
ava development user guide

 Plug-in Development Environment Gui| 'l' Getting Started
C/C++ Development User Guide

Eclipse Marketplace User Guide
> EGit Documentation

JavaScript Development Guide
Mylyn Documentation To help get the new GEM user started, this page will walk through examples of how to use GEM to formally verify a MPI Managed-Build project as well as a
P y y" | T | Pl tf (PTP) U G i larger MPI Makefile project. Please note that when we say “formally verify”, we mean "check the correctness” of your MPI application.

arallel Tools Platform ser Gul

B Contents For Exgmp(\;- - fEM will check your MPI application for the presence of:

. eadlocks

£ Overview . Functionally Irrelevant Barriers

B PTP Prerequisites MPI Object Leaks

& Local vs. Remote Projects kAOFEIB!rAS:Er\;l;::&I::?e?nS

B Creating an MPI Project P

B Synchronized Projects Some of these errors and problems are extremely difficult to detect and find with traditional debugging tools and practices.

=3 Resogrce Managers Remember that no code instrumentation is necessary. At compile time, GEM will link in its profiler library which takes care of everything for you
& Running Parallel Programs automatically (using the PMPI mechanism). GEM offers push-button formal verification for MPI C/C++ applications. Fortran support is planned in the future.
& Monitorin n m
onitoring Jobs _a d Systems The main idea here is to illustrate just how easy it is to do verification on your MPI application throughout your project's life-cycle. A developer can create,
& Parallel Debugging edit, compile, verify, parallel debug (for standard logic erors) and launch your MPI apps all from the comfort of the Eclipse IDE

This page serves to get the new GEM user up and running.

B PTP Preferences
= [0 Parallel Language Development Tools (F
# [0 External Tools Framework (ETFw)

[0 Graphical Explorer of MPI Programs (GE
& Contents
B GEM Overview
B Prerequi Please see the GEM Prerequisites Page. Particularly important, is the installation of In-situ Partial Order (ISP), the underlying formal verification engine GEM
b Getting Started serves as a front-end for.
B Setting the Number of Processes
& Analyzer View STEP - 2: Set ISP Command Line Options

B Browser View You'l need to tell GEM where ISP and its scripts (both local and remote) are installed and which of its command line options you would like to use. Please
Console View see the ISP Preference Page for detailed instructions (image below).

B Understanding conSOIe_OUtDUt STEP - 3: Set the Number of Processes to Verify With

& Happens Before (HB) Viewer (the same number of processes that you would run your MPI application with normally
B Makefile Project Support To do this, please consult the help page detailing Setting the num

B Remote Projects

B Preferences STEP - 4: Set Preference for Command Line Arguments Prompt

Depending on whether or not this preference is set, a dialog (figure 1 below) may be opened prior to verification (e.g. when GEM is run) to collect this
‘ information. Please see the G Preference Page for this (figure 2 below).

g a MPI Managed Build Project

STEP - 1: Make Sure all Prerequisites are Satisfied

E E
http://127.0.0.1:35710/help/nav/8_13
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Reference Slides

+ The following slides are not part of the presentation
or hands-on section.

+ They are meant to be used as further reference and
provide more detailed information on:

+ GEM setup, configuration and preference pages
+ Using GEM views

+ Help contribution

+ Troubleshooting

+ GEM Success stories

Module 5
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ISP Installation
+ ISP itself must be installed prior to using GEM

+Download ISP at
4+ Make sure libtool, automake and autoconf are installed.

+ Just untar isp-0.3.0.tar.gz into a tmp directory:
+ Configure and install
+ ./configure
+ make

+ make install
+ This installs binaries and necessary scripts
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GEM Analyzer View

+ Reports program errors, and runtime statistics

+ Debug-style source code stepping of interleavings
+ Point-to-point / Collective Operation matches
+ Internal Issue Order / Program Order views
+ Rank Lock feature - focus on a particular process

[2. Problems | & Console | GEM Analyzer £3 1 GEM Browser /. GEM Console

R | HB Viewer | 1= Browse MPI Calls

Step Order for MPI Calls—

{Runtime Informatio

+ Also controls:
+ Call Browser
+ Happens Before Viewer launch  [lESHsse L e
+ Re-launching of GEM ’ [

Transition: 14/133350———— Interleaving: 1/1

{ﬂjjj No Ranks Locked [!_‘_‘_IJJ [@ |||||||||||| QO Prograi m

Code Windows
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GEM Browser View
+ Tabbed browsing for each type of MPI error/warning

+ Each error/warning mapped to offending line of
source code in Eclipse editor

+ One click to visit the Eclipse editor, to examine:
+ Calls involved in deadlock
+ Irrelevant barriers [
+ MPI Object Leaks sites  [EE e —
+ MPI type mismatches
+ Local Assertion Violations




Search:

GEM -

Extensive how-to sections, graphical aids and

paratieltools platform

Help Plugin

trouble shooting section

Help - Eclipse

Scope: All topics

Contents
Workbench User Guide
C/C++ Development User Guide
Eclipse Marketplace User Guide
Mylyn WikiText User Guide

Parallel Tools Platform (PTP) User Guide

B
B
B
B

m
B
B

m
m
@

B
B8

Contents

Overview

PTP Prerequisites

Creating an MPI Project

Resource Managers

Launching Parallel Programs
Monitoring Parallel Machines and Jobs
Parallel Debugging

Parallel Language Development Tools (P!
External Tools Framework (ETFw)
Graphical Explorer of MPI Programs (GEM)
5 Overview

5 GEM Plug-in Prerequisites

2 GEM Plug-in Preferences

5 Understanding GEM Console Output
5 Console View

& Analyzer View

5 Happens Before Viewer

5 Makefile Support

2 Troubleshooting the GEM Plug-in
PTP Preferences

New and Noteworthy

Tasks User Guide
Usage Data Collector

Parallel Tools Platform (PTP) User Guide >

‘|' PTP: Graphical Explorer of MPI Programs (GEM)

Release 1.5.0

The Graphical Explorer of MPI Programs (GEM) Eclipse plug-in, part of the Parallel Tools Platform
(PTP), is a graphical front end for In-situ Partial Order (ISP), a dynamic formal verification tool for MPI
C/C++ programs, developed at the University of Utah. GEM greatly enhances the usability of ISP by
providing an intuitive graphical way to track down bugs in MPI C/C++ programs, examine
post-runtime results and to analyze MPI runtime behavior.

GEM can be used by anyone who can write simple MPI C/C++ programs, and requires no special
training. GEM allows you to formally verify your MPI C/C++ programs automatically without any extra
efforts on your part (apart from compiling and making your examples) and flags the following errors:

® Deadlocks
® Assertion violations
® Object leaks

In addition, GEM helps you understand as well as step through all relevant process interieavings
(schedules). Notice our use of the word relevant: even a short MPI program may have too many (an
"exponential number") of interleavings. For example, an MPI program with five processes, each
containing five MPI calls, can have well in excess of 1000 interleavings. However, ISP generates a
new interleaving only when it represents a truly new (as yet unexamined) behavior of your programs.

Overview, Background, and Setup information
1. e
2. GEM Plug-in Prerequisites

Help Topics
1. GEM Plug-in Preferences
. Understanding GEM Console Output

2
3
4.
5.
6.
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GEM/ISP Success Stories

+ Umpire Tests
+ http://www.cs.utah.edu/fv/ISP-Tests
+ Documents bugs missed by tests, caught by ISP

+ MADRE (EuroPVM/MPI 2007)

+ Previously documented deadlock detected

+ N-Body Simulation Code

+ Previously unknown resource leak caught during
EuroPVM/MPI 2009 tutorial !

+ Large Case Studies

+ ParMETIS, MPI-BLAST, IRS (Sequoia Benchmark), and a few
SPEC-MPI benchmarks could be handled

+ Full Tutorial including LiveDVD ISO available
+ Visit http://www.cs.utah.edu/fv/GEM

Module 5
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Module 6: Other Tools and
Wrap-up

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features

+ Contents

+ Links to other tools, including performance tools
+ Planned features for new versions of PTP

+ Additional documentation

+ How to get involved
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NCSA Blue Waters

m HPC Workbench

+ Tools for NCSA Blue Waters
*
+ Sustained Petaflop system

+ Based on Eclipse and PTP M¥{ﬁs
4+ Includes some related tools '

SUSTAINED PEIASCATF'W!P%

4+ Performance tools

+ Workflow tools (https://wiki.ncsa.uiuc.edu/
display/MRDPUB/MRD+Public+Space+Home
+Page)

+ Part of the enhanced computational environment
described at:
http://www.ncsa.illinois.edu/BlueWaters/ece.html
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NSF SI12 Workbench for High
Performance Computing

+ “SI2-SSI Productive and Accessible Development Workbench
for HPC Applications”, which is supported by the National
Science Foundation under award number OCI 1047956

+ Produce a productive and accessible development

workbench using Eclipse PTP
+ Key Components

+ Determining Requirements, Ensuring Impact
+ Make improvements to Eclipse PTP

+ Engineering Process

+ Metrics

+ Outreach/Training/Education
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Coding & NCSA HPC Workbench .

Analysis

(C/C++, Fortran)
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paratieltools platform

Planned PTP Future Work

+ Scalability improvements
+ Ul to support 1M processes
+ Very large application support

+ Usability improvements
+ New wizard to improve setup experience
+ Ability to share configuration information
+ Resource Managers

+ More implementations of configurable resource
managers

+ Synchronized project improvements

+ Conversion wizard
+ Resolving merge conflicts
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Useful Eclipse Tools

+ Linux Tools (autotools, valgrind, Oprofile, Gprof)
+ http://eclipse.org/linuxtools

+ Python
+ http://pydev.org

+ Ruby
+ http://www.aptana.com/products/radrails

+ Perl
+ http://www.epic-ide.org
+ Git
+ http://www.eclipse.org/egit

+ VI bindings
+ Vrapper (open source) - http://vrapper.sourceforge.net
+ ViPlugin (commercial) - http://www.viplugin.com

Module 6
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Online Information

+ Information about PTP
+ Main web site for downloads, documentation, etc.
+http://eclipse.org/ptp
+ Wiki for designs, planning, meetings, etc.
+http://wiki.eclipse.org/PTP
+ Articles and other documents
+http://wiki.eclipse.org/PTP/articles

+ Information about Photran
+ Main web site for downloads, documentation, etc.
+http://eclipse.org/photran
+ User’s manuals

+http://wiki.eclipse.org/PTP/photran/

documentation
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Mailing Lists

+ PTP Mailing lists

+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce

+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user

+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev

+ Photran Mailing lists
+ User discussion and queries
+ http://dev.eclipse.org/mailman/listinfo/photran

+ Developer discussions -
+ http://dev.eclipse.org/mailman/listinfo/photran-dev
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Getting Involved

+ See http://eclipse.org/ptp
+ Read the developer documentation on the wiki
+ Join the mailing lists

+ Attend the monthly developer meetings
+ Conf Call Monthly: Second Tuesday, 1:00 pm ET
+ Details on the PTP wiki
+ Attend the monthly user meetings
+ Teleconference Monthly
+ Each 4th Wednesday, 2:00 pm ET
+ Details on the PTP wiki

PTP will only succeed with your participation!
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PTP Tutorial Feedback

+ Please complete feedback form
+ Your feedback is valuable!

Thanks for attending
We hope you found it useful
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